All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of SEIKO EPSON CORPORATION. The information contained herein is designed only for use with this EPSON printer. EPSON is not responsible for any use of this information as applied to other printers.

Neither SEIKO EPSON CORPORATION nor its affiliates shall be liable to the purchaser of this product or third parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to strictly comply with SEIKO EPSON CORPORATION’s operating and maintenance instructions. SEIKO EPSON CORPORATION shall not be liable for any damages or problems arising from the use of any options or any consumable products other than those designated as Original EPSON Products or EPSON Approved Products by SEIKO EPSON CORPORATION.

EPSON, EPSON Stylus, and ESC/P are registered trademarks and Micro Piezo and ESC/P Raster are trademarks of SEIKO EPSON CORPORATION.

SoundAdvice is a service mark and MicroDot, PhotoEnhance, EPSON Digital PhotoLab, and EPSON FaxAdvice are trademarks of Epson America, Inc.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of their respective owners. EPSON disclaims any and all rights in those marks.

The ENERGY STAR emblem does not represent EPA endorsement of any product or service.
FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio or television reception. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause interference to radio and television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures.

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

**WARNING**

The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC Certification of this device and may cause interference levels which exceed the limits established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded equipment interface cable with this device. If this equipment has more than one interface connector, do not leave cables connected to unused interfaces. Changes or modifications not expressly approved by the manufacturer could void the user’s authority to operate the equipment.

**For Canadian Users**

This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.
Contents

Introduction
Windows System Requirements 2
Macintosh System Requirements 2
How To Use Your Manuals 3
  Warnings, Cautions, Notes, and Tips 4
Where To Get Help 5
ENERGY STAR Compliance 6
  Energy-saving Tips 7
Important Safety Instructions 7

1 Basic Printing
Printing from Windows 1-1
  Setting Printer Options from Windows Applications 1-2
  Setting Default Printer Options 1-4
  Checking Printer Status 1-6
Choosing Paper and Other Media 1-10
What To Do When the Printer Lights Flash 1-11

2 Custom Printing
Using Predefined Advanced Settings 2-2
Customizing Print Quality and Special Effects 2-4
Customizing Color Settings 2-8
Using ColorSync on the Macintosh 2-10
## Contents

Selecting Paper Size and Orientation Options 2-12
Selecting Paper Options in Windows 2-12
Selecting Paper Options on a Macintosh 2-17
Selecting Print Layout Options 2-20
Choosing Print Layout Options in Windows 2-21
Choosing Print Layout Options on a Macintosh 2-27
Saving Custom Settings 2-33
Redefining Custom Settings 2-34
Deleting Custom Settings 2-35

### 3 Printing on Special Media

Using Special Media 3-2
Additional Media Loading Guidelines 3-3
Envelopes 3-5
EPSON Photo Quality Ink Jet Cards 3-6
EPSON Photo Paper (4 x 6) 3-6
EPSON Ink Jet Transparencies 3-8
Panoramic Photo Paper and Banners 3-8
Loading Panoramic or Banner Paper 3-9
Printing a Panoramic Image from Windows 3-10
Printing a Panoramic Image from a Macintosh 3-11

### 4 Managing Print Jobs

Managing Print Jobs in Windows 95 4-1
Selecting the Speed & Progress Options 4-2
Using the Spool Manager 4-4
Using Status Monitor 2 4-5
Managing Print Jobs in Windows 3.1 4-11
Using the Spool Manager 4-11
Managing Print Jobs in Windows NT 4.0 4-13
Contents

Managing Print Jobs on a Macintosh 4-13
Using Monitor3 4-14
Using the Macintosh Status Monitor 4-16
Selecting Configuration Options 4-17

5 Maintenance and Transportation

Cleaning the Print Head 5-1
Using the Head Cleaning Utility 5-2
Using the Control Panel 5-3
Examining the Nozzle Check Pattern 5-4
Replacing an Ink Cartridge 5-4
Removing an Empty Ink Cartridge 5-5
Installing the New Cartridge 5-6
Replacing an Outdated Ink Cartridge 5-7
Aligning the Print Head 5-8
Cleaning the Printer 5-9
Transporting the Printer 5-9

6 Troubleshooting

Diagnosing Problems 6-1
Checking the Control Panel Lights 6-2
Running a Printer Check 6-3
Using the Printer and Option Information Utility 6-4
Uninstalling Printer Software 6-5
Improving Print Quality 6-7
Solving Printing Problems 6-9
Solving Printer Software Problems 6-12
Fixing Paper Problems 6-15
Solving Miscellaneous Printout Problems 6-17
Contents

A  Network Printing
Network Printing in Windows 95  A-1
Network Printing in Windows 3.1  A-3
  Setting Up the Print Server in Windows 3.1  A-4
  Setting Up Client Systems in Windows 3.1  A-4
Network Printing in Windows NT 4.0  A-5

B  Technical Specifications
Printing  B-1
Paper  B-2
Ink Cartridge  B-5
Mechanical  B-6
Electrical  B-6
Environmental  B-7
Safety Approvals  B-7
Initialization  B-7
Interface  B-8

Glossary

Index
Introduction

Your EPSON Stylus® Photo 700 printer is the ideal output device for full-color layout proofs, digital photography, photo editing—or any imaging project you create on your computer. The printer comes with these features:

- Exclusive Micro Piezo™ ink jet technology for smaller, cleaner dots
- Super MicroDot™ technology for superior image quality
- Six-color printing for photo reproduction quality on plain paper or a variety of special media
- Fastest color print speeds in its class
- Compatibility with Microsoft® Windows® and Macintosh®
- PhotoEnhance2 (PhotoEnhance™ in Windows 3.1) for optimizing the contrast, saturation, and brightness of your pictures at the touch of a button
- Resolutions up to 1440 × 720 dpi
- EPSON Digital PhotoLab™, which includes software for editing, compositing, and cataloging your digital photos
Introduction

Windows System Requirements

To use your printer and its software with a PC, your system should have:

- An IBM® compatible PC with at least a 486 DX2/66 MHz or faster processor (Pentium® 100 or equivalent recommended)
- Windows 3.1x, Windows 95 or later, or Windows NT 4.0
- At least 16MB of RAM (20MB recommended)
- At least 50MB of free hard disk space for storing images (100MB recommended)
- VGA, Super VGA, or better display adapter and monitor
- Double-speed CD-ROM drive (quad-speed or faster recommended)
- A shielded, twisted-pair parallel printer cable (6 to 10 feet long) to connect your computer to the printer; the cable must have a D-SUB, 25-pin, male connector for your computer and a 36-pin, Centronics® compatible connector for the printer.

Note: If you don’t have a CD-ROM drive, you can get the printer driver software on diskettes or download it through your modem. See your Getting Started guide for details.

Macintosh System Requirements

To use your printer and its software with a Macintosh, your system should have:

- Any Macintosh or Power Macintosh model except early models such as the Macintosh Classic, Macintosh +, Macintosh 512, or PowerBook™ 100
- System 7.1 or later (7.5 or later recommended)
- At least 16MB of built-in RAM (20MB is recommended)
- At least 50MB of free hard disk space for storing images (100MB recommended)
- 13-inch RGB or better display
Introduction

- Double-speed CD-ROM drive (quad-speed or faster recommended)
- Standard Apple® System Peripheral-8 cable or equivalent (RS-422, 8-pin mini DIN male/male, Belkin F2V024 recommended)

How To Use Your Manuals

To set up your printer, see the Getting Started guide. This User’s Guide contains the following information:

Chapter 1 covers the basics of printing with Windows or Macintosh.

Chapter 2 tells you how to print special projects with custom settings for print quality, color management, and distinctive layouts.

Chapter 3 gives guidelines for selecting and using the right paper or other media for your print job and instructions for printing panoramic images.

Chapter 4 explains how to manage print jobs and check printer status.

Chapter 5 gives instructions for replacing ink cartridges, cleaning and aligning the print heads, and cleaning and transporting the printer.

Chapter 6 provides solutions for any problems you may have.

Appendix A explains how to set up your computer and printer for network printing.

Appendix B provides the technical details of your printer, ink cartridges, and EPSON media.

A Glossary and an Index are included at the end of the book.
Introduction

Warnings, Cautions, Notes, and Tips

You'll find this information throughout your manual:

**Warnings** must be followed carefully to avoid bodily injury.

**Cautions** must be observed to avoid damage to your equipment.

**Notes** contain important information about your printer.

**Tips** contain additional hints for great printing.
Where To Get Help

EPSON provides technical assistance through electronic support services and automated telephone services 24 hours a day. The following tables list the contact information:

**Electronic support services**

<table>
<thead>
<tr>
<th>Service</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>EPSON Internet FTP Site</td>
<td>If you have Internet FTP capability, use your Web browser (or other software for FTP downloading) to log onto ftp.epson.com with the user name anonymous and your e-mail address as the password.</td>
</tr>
<tr>
<td>EPSON Download Service</td>
<td>You can call the EPSON Download Service at (800) 442-2007. Set your communications software to 8 data bits, 1 stop bit, no parity. Modem speed can be up to 28.8 Kbps.</td>
</tr>
<tr>
<td>EPSON Forum on CompuServe®</td>
<td>Members of CompuServe can type GO EPSON at the menu prompt to reach the Epson America Forum. For a free introductory CompuServe membership, call (800) 848-8199 and ask for representative #529.</td>
</tr>
</tbody>
</table>

**Automated telephone services**

<table>
<thead>
<tr>
<th>Service</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>EPSON SoundAdvice℠</td>
<td>For pre-recorded answers to commonly asked questions about EPSON products 24 hours a day, seven days a week, call (800) 442-2110.</td>
</tr>
<tr>
<td>EPSON FaxAdvice℠</td>
<td>Access EPSON’s technical information library by calling (800) 442-2110. You must provide a return fax number to use this service.</td>
</tr>
<tr>
<td>EPSON Referral Service</td>
<td>For the location of your nearest Authorized EPSON Reseller or Customer Care Center, call (800) 442-2110.</td>
</tr>
</tbody>
</table>
To speak to a technical support representative, dial (310) 533-4018 (U.S.) or (905) 709-2567 (Canada), 6 AM to 8 PM, Pacific Time, Monday through Friday and 7 AM to 4 PM, Saturday and Sunday. Toll or long distance charges may apply.

Before you call, please have the following information ready:

- Product name
- Product serial number
- Computer configuration
- Description of the problem

You can purchase ink cartridges, paper, manuals, accessories, and parts from EPSON Accessories at (800) 873-7766 (U.S. sales only). In Canada, please call (800) 873-7766 for dealer referral.

**ENERGY STAR Compliance**

As an ENERGY STAR Partner, EPSON has determined that this product meets the ENERGY STAR guidelines for energy efficiency.

The EPA ENERGY STAR Office Equipment program is a voluntary partnership with the computer and office equipment industry to promote the introduction of energy-efficient personal computers, monitors, printers, fax machines, and copiers in an effort to reduce air pollution caused by power generation.
Energy-saving Tips

Here are a few tips you can use to be even more energy-wise:

◗ If your monitor isn’t ENERGY STAR compliant, turn it off when you’re not using it.
◗ Turn off your computer, printer, and monitor each day when you are done using them.
◗ Use the print preview option in your software so you can catch errors before you print something.
◗ Send e-mail rather than distributing memos. Not only is this faster, but you’ll save paper and storage space too.

Important Safety Instructions

Before using your printer, read the following safety instructions to make sure you use the printer safely and effectively.

◗ Always use the power switch to turn the printer on or off. Never use an external switch—such as a power strip—to turn off the printer.
◗ Turn off and unplug the printer before cleaning. Clean with a damp cloth only. Do not spill liquid on the printer.
◗ Do not place the printer on an unstable surface or near a radiator or heating vent.
◗ Do not block or cover the openings in the printer’s cabinet or insert objects through the slots.
◗ Use only the type of power source indicated on the printer’s label.
◗ Connect all equipment to properly grounded power outlets. Avoid using outlets on the same circuit as photocopiers or air control systems that regularly switch on and off.
Introduction

Place the printer near a wall outlet where the plug can be easily unplugged.

Placez l'imprimante près d'une prise de contacte où la fiche peut être débranchée facilement.

Do not let the power cord become damaged or frayed.

If you use an extension cord with the printer, make sure the total ampere rating of the devices plugged into the extension cord does not exceed the cord’s ampere rating. Also, make sure the total of all devices plugged into the wall outlet does not exceed 15 amperes.

Except as specifically explained in this User’s Guide, do not attempt to service the printer yourself.

Unplug the printer and refer servicing to qualified service personnel under the following conditions:

If the power cord or plug is damaged; if liquid has entered the printer; if the printer has been dropped or the cabinet damaged; if the printer does not operate normally or exhibits a distinct change in performance. Adjust only those controls that are covered by the operating instructions.

Even if you are familiar with other types of printers, be sure to read through the following list of precautions before operating your ink jet printer:

Do not put your hand inside the printer or touch the cartridge during printing.

Under normal circumstances, ink will not come out of the cartridge. If it does get on your skin, wash it off with soap and water. If it gets in your eyes, flush them immediately with water.

Keep ink cartridges out of the reach of children.

Do not dismantle the ink cartridges or try to refill them. This could result in damage to the print head.

Once you install an ink cartridge, do not open the clamp or remove the cartridge except to replace it with a new one. The cartridge may become unusable otherwise.
Introduction

- Install the ink cartridge immediately after you remove it from its foil package. Leaving the cartridge unpacked for a long time before use may result in reduced print quality.
- Do not use an ink cartridge beyond the date printed on the cartridge carton. For best results, use up the ink cartridges within six months of installing them.
- Do not shake an ink cartridge; this can cause leakage.
- Always turn the printer off using the power button. When this button is pressed, the power light flashes briefly then goes out. Do not unplug the printer or turn off the power to the outlet until the power light is off.
- Before transporting the printer, make sure the print head is capped in the far right position and the ink cartridges are in place.
It’s easy to print with your new EPSON Stylus Photo 700. First set up and install the printer software, following the instructions in the *Getting Started* guide. Then read this chapter to learn about:

- Printing from Windows
- Printing from a Macintosh
- Choosing paper and other media
- What to do when the printer lights flash

### Printing from Windows

To print from your Windows application, click the print icon or choose *Print* from the File menu. You can then choose which pages to print, the number of copies, and other options. The settings that describe your print job—whether you want to use color or black ink, for example—are part of your printer driver software.

The following sections tell you how to set printer options from Windows applications, how to change the default printer settings, and how to check your printer’s status.
Basic Printing

Setting Printer Options from Windows Applications

This section describes the settings you'll need to make for all your everyday printouts. See Chapter 2 for information about special settings like PhotoEnhance2 (PhotoEnhance in Windows 3.1).

Follow these steps to check printer settings from your graphics application or other Windows software:

1. Choose Print, Print Setup, or Page Setup from the File menu. You see a printing dialog box.

   If you choose Print, you first see a Print dialog box that contains the settings you change most often, including the number of copies and the pages you want printed.

2. Make sure your EPSON Stylus Photo 700 printer is selected, and then click the Printer, Setup, Properties, or Options button. (You may have to click a sequence of these buttons.) You see a dialog box like the following:

   If you don’t see the dialog box shown above, click the Main tab.

Note: The settings you select through your application usually apply only until you exit that application.

Tip:
For more information about printer settings, click the Help button. In Windows 95 and Windows NT 4.0, you can right-click any item on the screen and then click What’s This?
3. Make sure the Mode option is set to Automatic. This lets the printer software determine the best settings for your print job and is the easiest way to get good printing results on all types of paper.

4. Choose the Media Type you want to print on from the following list (click the arrow button to scroll through the list). If you are not sure which setting to select, refer to the table on page 3-2.
   - Plain paper
   - 360 dpi Ink Jet Paper
   - Photo Quality Ink Jet Paper
   - Photo Paper
   - Photo Quality Glossy Film
   - Ink Jet Transparencies

   Your media choice may restrict the available range of settings such as print quality or resolution.

5. For the Ink setting, choose Color or Black.

6. Set the slider in the Mode box to Quality or Speed. This lets you choose between the highest resolution or the fastest printing for the media you're using. (The slider is not available when certain media types are selected.)

7. If necessary, click the Paper tab and choose your paper size, number of copies, orientation, and printable area. See page 2-12 for detailed instructions.

8. If you're using Windows 95 or Windows NT 4.0, click the Layout tab and check the proportional printing, page layout (Windows 95 only), and watermark options to make sure they're correct for your print job. See page 2-20 for details.

Tip
If you're printing grayscale images, choose Black as the Ink setting for faster output or choose Color for higher quality.
9. Click OK when you’re finished checking your settings.

10. Click OK or Print in your application’s printing dialog box. You may need to click a sequence of these buttons, depending on the application you are using.

   While your document is printing, the EPSON Progress Meter (Windows 95) or the EPSON Despooler dialog box (Windows 3.1) appears, showing the printing progress and the status of your printer. (See “Checking Printer Status” on page 1-6 for more information.)

Setting Default Printer Options

When you change printer settings through your software application, the settings apply only to the application you’re using. To adjust the default settings for all your Windows applications, you can access the dialog box through the Windows 95 or Windows NT 4.0 Printers utility or the Windows 3.1 Control Panel.

Make sure all your software applications are closed before you start. If not, you’ll have to close and then reopen them to have the new default settings take effect.
Setting Default Options in Windows 95 or Windows NT 4.0

Follow these steps:

1. Click **Start**, point to **Settings**, and then select **Printers**.

2. Right-click the **EPSON Stylus Photo 700** icon in the **Printers** window.

3. Select **Properties** (**Document Defaults** in Windows NT). Then click the **Main** tab.

   You see the printer settings dialog box, as shown on page 1-2. Any changes you make will become the default settings for all your applications and documents. Click **OK** when finished.

**Note:** You can access the default Windows NT printer software settings only if you have the appropriate network access privileges, such as Administrator or Power User.

Setting Default Options in Windows 3.1

Follow these steps:

1. Double-click the **Control Panel** icon in the **Main** group.

2. Double-click the **Printers** icon.

3. Select **EPSON Stylus Photo 700** from the list of installed printers and click **Setup**. You see the printer settings dialog box, similar to the one shown on page 1-2.

4. Make any changes you want to become the default settings for all your applications and documents, and click **OK** when you are finished.
Basic Printing

Checking Printer Status

While your document is printing, your printer software reports how the job is doing. See the section for your operating system below.

Windows 95

After you send a print job in Windows 95, the Progress Meter dialog box appears on your screen:

The Progress Meter shows the progress of your print job and the status of your printer. You can use the buttons to cancel, pause, or restart your print job. You can select whether to display the Progress Meter dialog box or not; see page 4-2 for instructions. If you installed Status Monitor 2, you also see information about how much ink you have left. See page 4-5 for more information about Status Monitor 2.
**Windows 3.1**

After you send your print job, the EPSON Despooler dialog box appears on your screen:

This dialog box shows the progress of your print job and the status of your printer. If you run out of paper while printing, for example, the Despooler warns you. You can use the buttons to cancel, pause, or restart your print job.

**Windows NT 4.0**

Windows NT 4.0 servers and workstations include a messenger service to alert you to printer errors or let you know when a print job is finished. If you have appropriate network access privileges or you’re controlling printing from the server, you can also cancel, pause, or restart print jobs and set other options. See your Windows NT documentation for details.

**Printing from a Macintosh**

When you print with a Macintosh, you need to check the page setup for documents in each application you use. You can then click the print icon or choose Print from the File menu. You see a dialog box that lets you choose the settings that describe your print job, such as Media Type.
Basic Printing

This section describes the settings you'll need to make for all your everyday printouts. See Chapter 2 for information about advanced settings.

Follow these steps to print from your word processor or other Macintosh application:

1. Choose **Page Setup** from the File menu. You see the Page Setup dialog box.

2. Choose your paper size and other page setup options and click **OK**. See page 2-17 for details.

3. Choose **Print** from the File menu or click the print icon in your application. You see a dialog box like the following:

   ![Print dialog box]

4. Choose the number of copies and indicate which pages you want to print.

5. Make sure the Mode option is set to **Automatic**. The printer software determines the best settings for your print job. This is the easiest way to get good printing results on all types of paper.

**Note:**
On the Macintosh, printer settings are saved with your document, but you can't save them from one application to another. You'll have to check your settings each time you print from a new application.

If you want to reuse settings, you can create custom setting groups in your printer software that you can select each time you open an application. See page 2-33 for details.
6. Choose the **Media Type** you want to print on from the following list. If you are not sure which setting to select, refer to the table on page 3-2.
   - Plain Paper
   - 360 dpi Ink Jet Paper
   - Photo Quality Ink Jet Paper
   - Photo Paper
   - Photo Quality Glossy Film
   - Ink Jet Transparencies

   The type of media you choose determines the print quality or resolution you can use.

7. Choose **Color** or **Black** ink.

8. Set the slider in the Mode box to **Quality** or **Speed**. This lets you choose between the highest resolution or fastest printing for the media you’re using. (The slider is not available for certain media types.)

9. Click the **Layout** button and check the print order (see page 2-20) proportional printing, page layout, and watermark options (see page 2-27) to make sure they’re correct for your print job. Then click **OK** to return to the printer settings dialog box.

10. Click **Print** when you’re finished checking your settings.

   If you’re printing grayscale images, choose Black as the Ink setting for faster output or choose Color for higher quality.

   If you chose background printing when you set up your printer, you can continue working while your document is printing. If you want to check the status of your print job, you can use EPSON Monitor3. See page 4-14 for details.
## Choosing Paper and Other Media

You can use most types of paper with your printer, but you’ll get better results with specially designed EPSON ink jet paper or other media. Following is a list of the media available for EPSON ink jet printers. See Chapter 3 for more information on using special paper and other media.

<table>
<thead>
<tr>
<th>Media name</th>
<th>Size</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>EPSON 360 dpi Ink Jet Paper</td>
<td>Letter, A4</td>
<td>S041060, S041059</td>
</tr>
<tr>
<td>EPSON High Quality Ink Jet Paper</td>
<td>Letter, A4</td>
<td>S041111, S041117</td>
</tr>
<tr>
<td>EPSON Photo Quality Ink Jet Paper</td>
<td>Letter, A4, Legal</td>
<td>S041062, S041061, S041067</td>
</tr>
<tr>
<td>EPSON Photo Quality Glossy Paper</td>
<td>Letter, A4</td>
<td>S041124, S041126</td>
</tr>
<tr>
<td>EPSON Photo Quality Glossy Film</td>
<td>Letter, A4, A6</td>
<td>S041072, S041071, S041107</td>
</tr>
<tr>
<td>EPSON Photo Paper</td>
<td>Letter, A4, 4 \times 6 Panoramic (precut to 8.3 \times 23.4 inches)</td>
<td>S041141, S041140, S041134, S041145</td>
</tr>
<tr>
<td>EPSON Ink Jet Transparencies</td>
<td>Letter, A4</td>
<td>S041064, S041063</td>
</tr>
<tr>
<td>EPSON Photo Quality Ink Jet Cards</td>
<td>A6, 8 \times 10</td>
<td>S041054, S041122</td>
</tr>
<tr>
<td>EPSON Photo Stickers Kit</td>
<td>A6, 16 frames per sheet (includes software)</td>
<td>S041144-KIT, S041144</td>
</tr>
<tr>
<td>EPSON Photo Stickers Refill</td>
<td>A6, 16 frames per sheet</td>
<td></td>
</tr>
<tr>
<td>EPSON Iron-On Cool Peel Transfer Paper</td>
<td>Letter, Letter</td>
<td>S041153 (10 sheets), S041155 (50 sheets)</td>
</tr>
<tr>
<td>EPSON Photo Quality Self Adhesive Sheets</td>
<td>A4</td>
<td>S041106</td>
</tr>
</tbody>
</table>

To order EPSON papers and other media, contact your dealer or call EPSON Accessories at (800) 873-7766 (U.S. sales only). In Canada, please call (800) 873-7766 for dealer referral.
What To Do When the Printer Lights Flash

The four lights on your printer’s control panel show the printer’s status and alert you to problems like paper jams.

- When the paper out light comes on, your paper ran out or is incorrectly loaded. Load paper in the sheet feeder and then press the load/eject button.
- When the paper out light flashes, you have a paper jam. Take all of the paper out of the sheet feeder, reload the paper, then press the load/eject button. If the light continues to flash, turn off the printer and gently pull out any jammed paper.
- When an ink out light flashes, your ink supply is low. Make sure you have a replacement cartridge.
- When an ink out light comes on, you need to replace the ink cartridge. See Chapter 5 for instructions.
- The power light is on when the printer is on. The power light flashes when the printer is receiving a print job or performing a maintenance operation such as cleaning a print head.
Basic Printing

When the power and paper lights flash and the ink out lights are on, your printer has a carriage error. Turn off the printer by pressing the power button; wait several seconds; then turn it on again. If this does not clear the error condition, contact EPSON as described in the Introduction.

When all the lights flash, your printer may have an internal error. Turn off the printer by pressing the power button; wait several seconds; then turn it on again. If this does not clear the error condition, contact EPSON as described in the Introduction.
When your photographs or other projects have special printing requirements, you can use the custom settings in your EPSON Stylus Photo 700 software. You can choose predefined settings or adjust individual options like brightness, contrast, saturation, and halftoning. For professional-quality color accuracy, you can use Image Color Matching (ICM) under Windows 95 or ColorSync™ on the Macintosh.

If you’re using Windows 95, Windows NT 4.0, or a Macintosh, your printer software’s layout options let you print almost any size image on your printer and add watermarks. In Windows 95 and Macintosh, you can also proof multiple pages on one sheet of paper.

This chapter includes the following information:

- Using predefined advanced settings
- Customizing print quality and special effects
- Customizing color settings
- Using ColorSync on the Macintosh
- Selecting paper size and orientation options
- Selecting print layout options
- Saving custom settings
Using Predefined Advanced Settings

Predefined settings provide an easy way to enhance your photos and fine-tune your printer’s operation. Follow these steps to print with predefined settings:

1. Create your image or project in your application software.

2. Access the printer settings dialog box as described on page 1-2 (Windows) or page 1-7 (Macintosh).

3. Select Color or Black Ink.

4. Click Advanced, and then click the arrow button next to Custom Settings (Windows) or Custom (Macintosh) to display a list of project types.
Select the right setting for your project by following these guidelines. Not all media types are available when using some of these settings.

- **Advanced Photo**
  For printing high-quality scanned photographs. Enables the Super MicroWeave setting, which may slow printing (see page 2-7 for details).

- **Photo**
  For printing scanned photographs in less time. Increases the contrast of the image.

- **Text/Graph**
  For printing graphics-intensive documents such as presentation pages with charts and graphs. Intensifies colors and lightens the midtones and highlights.

- **PhotoEnhance2** or **PhotoEnhance** (Windows 3.1)
  For printing images captured using a video camera, digital camera, or scanner. Produces sharper images and more vivid colors by automatically adjusting the contrast, saturation, and brightness. Corrects for under- and over-exposure of the original image.

- **Text**
  For faster printing of text-only documents on plain paper.

- **Economy**
  For rough drafts of text only, on plain paper. Saves ink.

- **ICM** (Windows 95 only)
  Automatically adjusts printout colors to match the colors on your screen.

- **ColorSync** (Macintosh only)
  Automatically adjusts printout colors to match the colors on your screen. For more information, see page 2-10.

---

Tip:
The Photo setting and the PhotoEnhance2 (PhotoEnhance on Windows 3.1) setting have similar effects. However, PhotoEnhance2 and PhotoEnhance intelligently analyze your image data; effects vary widely depending on your image. The Photo setting consistently increases contrast. You may have to experiment to choose the best setting for your needs.

Note:
Printing with Advanced Photo, PhotoEnhance2, or PhotoEnhance may take longer, depending on your image and computer system.

---

Custom Printing
Custom Printing

6. Choose the Media Type you want to print on. (If you’re not sure which setting to select, see the table on page 3-2.) The available media are limited by the predefined setting you chose in step 5. For example, you can’t use plain paper or transparencies with the ICM or ColorSync settings.

7. In Windows, check or change any necessary settings on the Paper and Layout (not available in Windows 3.1) tabs as described on page 2-12 and page 2-21.

On a Macintosh, check or change any necessary settings in the Page Setup and Layout dialog boxes as described on page 2-17 and page 2-27.

8. When you’re finished, click Print (Macintosh) or OK (Windows). If you’re using Windows, click any other buttons that your application uses for printing.

Customizing Print Quality and Special Effects

If you need the maximum control over your photos, or you want to experiment with special effects, you can adjust individual settings in your printer software. Follow these steps:

1. Create your image or project in your application software.

2. Access the printer settings dialog box as described on page 1-2 (Windows) or page 1-7 (Macintosh).
3. Click **Advanced**, and then click **More Settings**. You see the More Settings dialog box:

![Windows 95 More Settings dialog box](image)

Some of these options are automatically set or disabled by other settings you choose.

![Macintosh More Settings dialog box](image)

Some of these options are automatically set or disabled by other settings you choose.
Custom Printing

4. Choose one of the following Print Quality options:
   - **Economy**
     For low-resolution rough drafts on plain paper. Saves ink.
   - **Normal - 360 dpi**
     For printing on plain paper, transparencies, or 360 dpi ink jet paper.
   - **Fine - 720 dpi**
     For high-resolution output. Works best on photo quality media.
   - **SuperFine - 1440 dpi**
     For the highest-resolution output. Works only on photo quality media and photo paper.

5. Choose the Media Type and Ink settings you want to use, following the guidelines in Chapters 1 and 3.

6. Choose one of the following Halftoning options:
   - **No Halftoning**
     For black text only.
   - **Error Diffusion**
     For photographic images. Blends each dot of color with the surrounding dots.
   - **Fine Dithering**
     For charts, graphs, and other images that require precise, solid areas of bright colors. Arranges dots in orderly patterns.
7. Choose which of the following options you want for your project. Some of these settings are automatically selected or disabled by the Media Type and Print Quality (resolution) you choose.

- **MicroWeave**
  For improved print quality. Prints graphic data in finer increments to eliminate unwanted banding effects (light horizontal lines). Always use for color printing.

- **Super MicroWeave**
  This setting is available at 720 dpi when using plain paper, and at 1440 dpi when using photo quality media. Use if MicroWeave doesn’t eliminate banding in your printout. Printing may be slower.

- **High Speed**
  For fast, bidirectional printing at lower quality.

- **Flip Horizontal**
  Prints a mirror image of your document. For example, use this setting when printing with iron-on transfer paper, so when you iron the printout onto a T-shirt or other item, it will read correctly.

- **Finest Detail**
  For printing text, graphics, and line art with very sharp edges. Slows print speed and increases your system memory requirements.

8. Click OK if you’re ready to return to the printer settings dialog box, or see the next section if you want to adjust your printer’s color settings.
Custom Printing

Customizing Color Settings

You can choose from several color adjustment modes or manually adjust brightness, contrast, and saturation. For professional color correction, you can set individual CMY color values. To improve brightness, contrast, and saturation when printing digital images, you can use PhotoEnhance2 or PhotoEnhance (Windows 3.1). To achieve the maximum color accuracy, you can use Image Color Matching (ICM) under Windows 95 or ColorSync on the Macintosh.

Follow these steps to customize your color settings:

1. Access the More Settings dialog box as described on page 2-4.

   The color settings appear on the right side of the dialog box, as shown:

   Windows
   (ICM is available only for Windows 95)

   Macintosh
   (ColorSync is available only for Macintosh)
2. Choose one of the following **Color Adjustment Modes**. If you are using ICM or ColorSync, these settings are not available.

- **Automatic**
  Analyzes the color information in your image and optimizes color correction accordingly.

- **Photo-realistic**
  For increased contrast in color photographs.

- **Vivid**
  For printing graphics-intensive documents like presentation pages with charts and graphs. Intensifies colors and lightens the midtones and highlights.

- **No Color Adjustment**
  Disables color adjustment. Use this setting if you wish to use a stand-alone color management utility.

3. If you want to specify individual color correction values, use the sliders to increase (drag right) or decrease (drag left) the settings listed below. (If you want to use the options described in step 4, you won’t be able to specify individual color correction values.)

- **Brightness**
  Makes your image lighter or darker.

- **Contrast**
  Increases or decreases the difference between the bright or dark parts of an image.

- **Saturation**
  Makes colors more vivid or less vivid.

- **Cyan, Magenta, Yellow**
  Increases or decreases individual color values. The **Cyan** and **Magenta** settings also affect the light cyan and light magenta inks. Use these sliders to fine-tune the color balance in your printout.
4. Other image enhancement options include:

- **PhotoEnhance2 or PhotoEnhance** (Windows 3.1)
  Produces sharper images and more vivid colors by automatically adjusting the contrast, saturation, and brightness. Corrects for over- or under-exposure of the original photograph. Does not affect text or vector graphics.

- **ICM** (Windows 95 only)
  Automatically adjusts printout colors to match colors on the screen. Requires ICM monitor and printer profiles. Printer profiles are installed with your printer software. Check your monitor documentation to see whether your monitor includes ICM profiles.

- **ColorSync** (Macintosh only)
  Automatically adjusts printout colors to match colors on the screen. See “Using ColorSync on the Macintosh” for more information.

5. Click **OK** to return to the printer settings dialog box.

**Using ColorSync on the Macintosh**

Every device you use for viewing or producing colors—your monitor, scanner, and printer—uses a different color technology. That’s why it’s difficult to get printed colors to match the colors displayed on your monitor.

Each device has its own gamut, or range of colors that it can reproduce. The Macintosh ColorSync system translates colors from one gamut to another so your monitor’s colors match your printer’s as closely as possible.

ColorSync uses profile information from each device—including your EPSON Stylus Photo 700—to achieve accurate color matching. First you have to make sure your monitor’s profile is set. Then you can use your printer software to specify the exact method of gamut mapping (color matching) you want to use.
Follow these steps to set your monitor’s ColorSync profile and use your printer software’s ColorSync features:

1. Open ColorSync System Profile under Control Panels on the Apple menu.

2. Click the Set Profile button.

3. Select your monitor from the list, and then click Select.


5. Access the More Settings dialog box as described on page 2-4.

6. Click ColorSync.

7. For Profile, choose EPSON Standard. Do not choose any other profiles that may be listed.

8. Choose one of the following options for Rendering Intent:
   - Perceptual
     Scales the displayed colors to fit within the printer’s gamut. Maintains the relationship between colors.
   - Saturation
     For printing graphics-intensive documents like presentation pages with charts and graphs. Maintains the relative saturation of colors from one gamut to another.
   - Colorimetric
     For matching colors as precisely as possible. Maintains colors that fall within the gamut of both the monitor and printer, but may lose some detail in areas where the colors are outside the printer’s density range.

9. Click OK to return to the printer settings dialog box.
Selecting Paper Size and Orientation Options

Your printer can print on paper up to 9.5 inches wide and up to 44 inches long in either portrait or landscape orientation. If you print multiple page documents or multiple copies of documents, you can print the pages collated and in reverse order. You can even rotate the printed image by 180 degrees to bring it closer to the bottom of the paper (not available with Windows 3.1).

Selecting Paper Options in Windows

Follow these steps to select paper options on the Paper tab:

1. Create your image or project in your application software.
2. Access the printer software dialog box as described on page 1-2.
3. Click the Paper tab. You see the Paper dialog box:

![Paper dialog box diagram]

- Click to select your Paper Size
- Page graphics change to show Collate and Reverse Order settings (not available in Windows NT 4.0)
- Rotate by 180° is not available with Windows 3.1
- Printer graphic reflects changes to Orientation and Printable Area settings
4. Click the **Paper Size** drop-down list to select the size of paper you loaded in the printer.

The sizes marked with an asterisk (*) are not available in Windows 3.1. They are larger than you can load in your printer and can be used only with the Proportional Printing setting on the Layout tab; see page 2-21 for more information.

- A4 210 × 297 mm
- B5 182 × 257 mm
- A5 148 × 210 mm
- Letter 8 1/2 × 11 in
- Legal 8 1/2 × 14 in
- Executive 7 1/4 × 10 1/2 in
- Half Letter 5 1/2 × 8 1/2 in
- A6 Index Card 105 × 148 mm
- Index card 5 × 8 in
- Index card 8 × 10 in
- Envelope #10 4 1/8 × 9 1/2 in
- Envelope DL 110 × 220 mm
- Envelope C6 114 × 162 mm
- Photo Paper 4 × 6 in
- Panoramic 210 × 594 mm
- B4 257 × 364 mm*
- B3 364 × 514 mm*
- Ledger 11 × 17 in*
- A3 297 × 420 mm*
- Super A3/B 329 × 483 mm*
- A2 420 × 594 mm*
- US C 17 × 22 in*
- User Defined (See page 2-15 for instructions.)

5. If you did not or cannot select the number of copies you want to print in your application program’s Print dialog box, choose the number (from 1 to 99) in the **Copies** box. Don’t select the number of copies here and in your application’s Print dialog box; you’ll get twice the number of copies you want.
Custom Printing

6. If you’re printing multiple copies of a multi-page document and you want the copies printed in sets, click the **Collate** checkbox (not available in Windows NT 4.0). The page graphics change to show collated documents.

7. If you’re printing a multi-page document and want the last page printed first so the pages come out without needing to be reordered, click the **Reverse Order** checkbox (not available in Windows NT 4.0). The page graphics change to show later pages printing first.

8. Select the direction of printing on the page using the **Orientation** options. To print your document oriented as shown in one of the following printer graphics, select the options listed below it.

   ![Portrait orientation](Portrait.png) ![Landscape orientation](Landscape.png)

   ![Portrait orientation](Portrait_rotate.png) ![Landscape orientation](Landscape_rotate.png)

9. To use the maximum printable area of your selected paper size, set the **Printable Area** option to **Maximum**. To center your image on the page, select **Centered** (this makes all margins equal and reduces the printable area). The page graphic changes to show your selection.

10. Click a tab for the settings you want to check or change next, or click **OK** to print your document.
Creating User Defined Paper Sizes

You can create up to 10 custom paper sizes (one in Windows 3.1) and add them to the Paper Size list using the User Defined option. This is useful if you’re printing a custom size document, such as a banner. You can select any width from 3.94 to 9.5 inches, and any height (length) from 3.94 to 44 inches.

Follow these steps to create a custom paper size with the User Defined option:

1. Follow the steps on page 1-2 to access the printer software and select the Paper tab.

2. Click the Paper Size list and scroll to the bottom of it using the arrows or scroll bar.

3. Click the User Defined option. You see one of the following dialog boxes:

   - Windows 95 or Windows NT
     Type a name (up to 24 characters) for your custom paper size in the Paper Size Name field. Then select a Paper Width and Paper Height for the paper. To use centimeters instead of inches, click the 0.01cm Unit option. When you’re finished, click Save. The paper size name appears in the Paper Size list in the dialog box. Add more sizes if you want, and click OK when you’re done.

   - Windows 3.1

Note: In Windows 95 and Windows NT, the Paper Width and Paper Height units are in hundredth of an inch (or centimeter) increments. For example, 850 equals 8.50 inches.
Custom Printing

Windows 3.1
You can only create one User Defined paper size. Type the width in the Paper Width field and the length in the Paper Height field. Then click OK.

5. You see the Paper tab again. The paper size name you defined is added to the Paper Size list and selected as the current setting. (In Windows 3.1, the setting is named User Defined.)

Changing or Deleting User Defined Paper Sizes

Follow these steps to delete or change paper sizes:

Windows 95 or Windows NT
1. Click User Defined in the Paper Size list.
2. On the User Defined Paper Size dialog box, select the custom paper name in the Paper Size list and click Delete or change the Paper Width, Paper Height, and/or Unit settings as necessary.
3. Click the Save button to save any changes, and click OK when you’re done.

Windows 3.1
You can change the custom paper size, but cannot delete it.
1. Click User Defined in the Paper Size list.
2. On the User Defined Paper Size dialog box, change the Paper Width and Paper Height settings as necessary.
3. Click OK when you’re done.
Selecting Paper Options on a Macintosh

The Paper Size and Orientation options are on the Page Setup dialog box. The options for collating and reversing the page order are on the Layout dialog box. Follow the steps in these sections for selecting the paper options:

- Choosing paper size and orientation options
- Selecting print order options

Choosing Paper Size and Orientation options

Follow these steps to select the Paper Size and Orientation options:

1. Create your image or project in your application software.

2. Open the File menu and select Page Setup. You see the Page Setup dialog box:

3. Click the Paper Size pop-up list to select the size of paper you loaded in the printer:

   - A4
   - B5
   - A5
   - Letter
   - Legal
   - Executive
   - Half Letter
   - Envelope #10
   - Envelope C6
   - Envelope DL
   - A6 Index Card
   - Index card 5 × 8 in
   - Index card 8 × 10 in
   - EPSON Photo Paper 4 × 6 in
   - Panoramic 210 × 594 mm

If you don’t see the exact size you need in the list, you can create a custom paper size; see page 2-19 for instructions.
4. Select the direction of printing on the page using the Orientation options. To print your document oriented as shown in one of the following printer graphics, select the options listed below it.

5. To use the maximum printable area of your selected paper size, set the Printable Area option to Maximum. To center your image on the page, select Centered (this makes all margins equal and reduces the printable area).

6. If you want to collate multiple copies of a multi-page document or you want to reverse the order in which pages are printed, click OK. Then see page 2-20 for instructions.

If you’ve finished selecting page size and orientation options, click OK to close the Page Setup dialog box. Then select Print from the File menu to select any other printer settings you may need and print your document.

Note:
The Rotate by 180° setting lets you print the lower portion of a document first, with a bottom margin as small as 0.12 inch (3 mm) and a top margin as small as 0.55 inch (14 mm).
Creating Custom Paper Sizes

You can create up to 8 custom paper sizes and add them to the Paper Size list. This is useful if you’re printing a custom size document, such as a banner. You can select any width from 3.94 to 9.5 inches, and any height (length) from 3.94 to 44 inches.

Follow these steps to create a custom paper size:

1. Follow the steps on page 2-17 to access the Page Setup dialog box.

2. Click the Customize button. You see the following dialog box:

3. Click the New button. Width and Height fields and Inches and cm radio buttons appear on the screen.

4. Type the width and length of your custom paper in the Width and Height fields. If you need to change from inches to centimeters, click the correct radio button.

5. Type a name for your custom paper size in the New Paper Size field, then click OK. The name is added to the Paper Size list and selected as the current setting in the Page Setup dialog box.

6. To delete a custom paper size, click the Customize button. Then click the name of the custom paper size, and click Delete. Click OK to return to the Page Setup dialog box.
Custom Printing

Selecting Print Order Options

Follow these steps to use the Collate and Reverse Order options:

1. Open your application program’s File menu and select Print.

2. Click the Layout button. You see the Layout dialog box:

3. If you’re printing multiple copies of a multi-page document and you want the copies printed in sets, click the Collate checkbox. The page graphics change to show collated documents.

4. If you’re printing a multi-page document and want the last page printed first so the pages come out without needing to be reordered, click the Reverse Order checkbox. The page graphics change to show later pages printing first.

5. Click OK to close the Layout dialog box.

Selecting Print Layout Options

Your printer software’s print layout options let you reduce or enlarge almost any size image to print on your printer. You can also select options to proof multiple pages on one sheet of paper, add page frames, and add a predefined or custom watermark.

Note:
For information on the other settings on the Layout dialog box, see page 2-27.

Note:
Layout options are available only when you’re using Windows 95, Windows NT, or a Macintosh.
Choosing Print Layout Options in Windows

Follow the steps in these sections to use options in the Layout dialog box:

- Using proportional printing
- Using multiple print layouts and page frames
- Adding a watermark

Using Proportional Printing

When you want to make the printed size of a document different from its actual size, you can use your printer software's proportional printing features to reduce or enlarge it, without having to reformat the document. You can proportion the document to fit on a selected paper size, or reduce or enlarge it by a selected percentage.

Follow these steps to use proportional printing:

1. Follow the steps on page 2-12 to access the printer software and select the Paper tab.

2. Click the Paper Size list and select the actual size of the page you want to print.

   For example, if your document size is 11 x 17 inches and you want to reduce it to fit on Letter-size paper, select Ledger 11 x 17 in. If your document size is 5 x 8 inches, but you want to enlarge it to fit on Letter-size paper, select Index card 5 x 8 in.

3. If the Paper Size setting you selected for your document is within the maximum paper size that can fit on your printer, you need to select proportional printing manually. Go to step 5.
Custom Printing

4. If the **Paper Size** setting you selected is *larger* than the maximum size that can be printed on your printer, you see the following dialog box:

```
In the **Output Paper** list, select the actual size of the paper loaded in the printer and click **OK**. This automatically turns on proportional printing and sets the correct reduction percentage so the document fits into the printable area on the output paper you select.

The selected **Paper Size**, reduction percentage, and **Output Paper** settings now appear on the printer graphic. If you want to adjust the proportions or sizes, go to step 5. If you’re ready to print, go to step 7.
```
5. Click the Layout tab. You see the Layout dialog box:

6. Select one of the following proportional printing options:
   - Select **Normal** to set the print proportion to 100%.
   - Select **Fit to Page** to automatically reduce or enlarge the image to fit on the paper size loaded in the printer. The Paper Size option beneath the Fit to Page option becomes active; select the size of paper loaded in the printer.
   - Select **Custom** to reduce or enlarge the image by a specific percentage (10% to 400%).

7. If you’re finished selecting Layout options, click **OK**.
   If you want to select more options, see the next sections.
Custom Printing

Using Multiple Print Layouts and Page Frames
(Windows 95 only)

If you’re printing a multiple page document, but you want a quick proof of the images on each page printed on one piece of paper, you can select Print Layout options in the printer software. You can choose the way the pages are placed on the paper and add a lined frame to each page, if you want.

Follow these steps to use the Print Layout options:

1. To print multiple pages of your document on one sheet of paper, select either the 2 Pages or 4 Pages radio button.

2. If the page order of the layout shown in the printer graphic is how you want your document printed, go to step 3.

   To change the page order, click the Page Order button. Then select the page order you want to use from the Print Layout dialog box that appears.

3. If you want to frame each page's contents with a black line, click the Print page frames checkbox.

4. If you’re finished selecting Print Layout options, click OK.

   If you want to select more options, see the next section.
Adding a Watermark

You can add a watermark to each page in your document to emphasize its purpose or indicate how the document should be handled. For example, you may want to add a watermark of the word “Confidential” to documents you don’t want distributed to other parties. Or you can add a custom bitmap of your company logo so your document looks like printed letterhead.

Follow the steps below to add a predefined or custom watermark.

1. To turn on the watermark feature, click the Watermark checkbox.

2. The default watermark is Confidential. To change the watermark or specify how it appears, click the Watermark Settings button. You see the following dialog box:

Note: To add a custom watermark, you must first create the watermark as a bitmap in an application program that can create bitmap files. See your application’s documentation for instructions.
3. To select a different predefined watermark, click the arrow in the Watermark drop-down list and choose one of the following options:

- Confidential
- Draft
- Urgent
- Priority
- Hot
- Do Not Copy
- For Your Eyes Only
- Review Copy
- Top Secret
- Duplicate

Then go to step 5.

4. To load a custom watermark you’ve created as a bitmap in an application program, click the User Defined button. You see the following dialog box:

Click the Browse button. You see the Select a bitmap file dialog box. Navigate to the folder containing the bitmap file you want to use, select the file, and click OK.

Type a name for the custom watermark (up to 24 characters long) in the Watermark field. Click the Save button to add it to the list, then click OK.

The custom watermark now appears as the selected watermark in the Watermark Settings dialog box and is shown in the Layout graphic.
5. Now select the way you want the watermark to appear by choosing the following options. The Layout graphic changes to reflect all the settings you choose.

- **Position** selects where you want the watermark to appear on your page: Center, Top-Left, Top-Right, Bottom-Left, or Bottom-Right.
- **Size** adjusts the size of the watermark, either larger or smaller, as you move the slide bar.
- **Color** lets you choose a color for your predefined watermark: Red, Black, Blue, Aqua, Lime, Fuchsia, or Yellow. You cannot select a color for custom watermarks; they are the same color as the original bitmap.
- **Intensity** sets the lightness or darkness of the watermark (from 5% to 100%) based on where you move the slide bar.

6. Click **OK** to accept your Watermark Settings.

7. If you’re finished changing Layout options, click **OK** to close the Layout dialog box.

### Choosing Print Layout Options on a Macintosh

Follow the steps in these sections to use options in the Layout dialog box:

- Using the Fit to Page option
- Using multiple print layouts and page frames
- Adding a watermark
Using the Fit to Page Option

When you want to make the printed size of a document different from its actual size, you can use your printer software’s Fit to Page option to proportion it to fit on a selected paper size.

Follow these steps to use the Fit to Page option:

1. Create your image or project in your application software.

2. Open the File menu and select Page Setup. You see the Page Setup dialog box.

3. Click the Paper Size list and select the actual size of the image you want to print. For example, if your image size is 8 1/2 × 11 inches, select Letter for the Paper Size option.

   If you want to print this image at the maximum size on 4 × 6-inch EPSON Photo Paper, you’ll use the Fit to Page option to reduce the image to that size. If you want to print this image at the maximum size on Legal-size paper (8 1/2 × 14 inches), you’ll use the Fit to Page option to enlarge the image to that size.

4. Click OK to close the Page Setup dialog box.

5. Now open the File menu and select Print.

6. Click the Layout button. You see the Layout dialog box:
7. Select one of the following Fit to Page options:
   - Select Off to set the print proportion to 100%.
   - Select On to automatically reduce or enlarge the image to fit on the paper size loaded in the printer. The Paper Size option beneath the Fit to Page option becomes active.

Now select the size of the paper you’ve loaded in the printer. This automatically sets the correct reduction or enlargement percentage so the image fits into the printable area on the paper size you select. The selected image size and paper size settings now appear beneath the printer graphic.

8. If you’re finished selecting Layout options, click OK. If you want to select more options, see the next sections.
Custom Printing

Using Multiple Print Layouts and Page Frames

If you’re printing a multiple page document, but you want a quick proof of the images on each page printed on one piece of paper, you can select Print Layout options in the printer software. You can choose the way the pages are placed on the paper and add a lined frame to each page, if you want.

Follow these steps to use the Print Layout options:

1. To print multiple pages of your document on one sheet of paper, select either the 2 Pages or 4 Pages in the Pages pop-up list.

2. If the page order of the layout shown in the printer graphic is how you want your document printed, go to step 3.

   To change the page order, click the arrow in the Page Order pop-up list. Then select the page order you want to use.

3. If you want to frame each page’s contents with a black line, one dot wide, click the Print page frames checkbox.

4. If you’re finished selecting Layout options, click OK.

   If you want to select more options, see the next section.
Adding a Watermark

You can add a watermark to each page in your document to emphasize its purpose or indicate how the document should be handled. For example, you may want to add a watermark of the word “Confidential” to documents you don’t want distributed to other parties. Or you can add a custom PICT file of your company logo so your document looks like printed letterhead.

1. To use one of the predefined watermarks, click the arrow in the Name pop-up list in the Watermark box. Then choose one of the following options:

   Confidential  Do Not Copy
   Draft         For Your Eyes Only
   Urgent        Review Copy
   Priority      Top Secret
   Hot           Duplicate

   Then go to step 3.

2. To load a custom watermark you’ve created as a PICT file in an application program, click the Add/Delete button. You see the following dialog box:

   ![Watermark Dialog Box]

   Click the Add button to select a PICT file

   Click the Add button. You see a dialog box for selecting files. Navigate to the folder containing the PICT file you want to use, select the file, and click Open.

   Note: To add a custom watermark, you must first create the watermark as a PICT file in an application program that can create PICT files. You can create up to 10 custom watermarks from PICT files up to 1MB in size.

   See your application’s documentation for instructions.

   To delete a custom watermark you’ve added to the list, click the Add/Delete button. Then select the watermark and click Delete. Click Save to close the dialog box.

   If you selected a multiple page print layout option (as described on page 2-30), your watermark will appear on each page in the layout.
The name of your PICT file appears in the **Name** field and is added to the Watermark List. Click the **Save** button to close the dialog box.

The custom watermark now appears as the selected watermark in the Layout dialog box and is shown in the Layout graphic.

3. Now select the way you want the watermark to appear by choosing the following options. The Layout graphic changes to reflect all the settings you choose.

- **Color** lets you choose a color for your predefined watermark: **Red**, **Black**, **Blue**, **Aqua**, **Lime**, **Fuchsia**, or **Yellow**. You cannot select a color for custom watermarks; they are the same color as the original PICT file.

- **Intensity** sets the lightness or darkness of the watermark (from 5% to 100%) based on where you move the slide bar.

- To adjust the size and position of the watermark, move the cursor over the Layout graphic. Four boxes appear in the corners of the graphic and the cursor changes to a hand.

To move the watermark, click anywhere inside the graphic and drag it into one of five positions: center, upper-right, upper-left, lower-right, or lower-left.
To resize the watermark, move the cursor over one of the corner boxes; the cursor changes to a pointing hand. Click and drag the box corner to reduce or enlarge the watermark.

4. If you're finished changing Layout options, click OK to close the Layout dialog box.

**Saving Custom Settings**

After you've fine-tuned your printer settings for a special project, you can save the settings as a group. Then you can quickly reuse them the next time you print a similar project. You can save up to 10 groups of settings. Follow these steps:

1. Customize your printer settings as described in this chapter.

2. Click **Advanced**, and then click the **Save Settings** button on the main printer software dialog box. You see one of the following:

   ![Custom Settings](image-url)
3. Type a unique name for your settings (up to 16 characters) and click the Save button.

The name you choose will now be available on the printer settings dialog box. To use the settings, click Advanced. Then open the Custom Settings list and double-click the name you selected for your custom settings group.

To redefine or delete your custom settings, see the next sections.

Redefining Custom Settings

To change the options in a customized settings group but keep the same name for it, follow these steps:

1. Select Advanced mode. Then select the name of the custom settings group you want to redefine in the Custom Settings list.

2. Change the printer settings as necessary. (If you change the Media Type and Ink settings, the custom settings group name reverts to Custom Settings; this doesn’t affect your customized setting.)

3. Click Save Settings. Then select the name of the custom settings group you're redefining in the Custom Settings box.

4. If you're using Windows, click Save. You see the Save As dialog box. Click OK to save your redefined settings. (Click Cancel to cancel your changes.)

   On a Macintosh, click the Redefine button. Then click Replace at the confirmation dialog box to save your redefined settings. (Click Cancel to cancel your changes.)
Deleting Custom Settings

1. Select Advanced mode. Then click Save Settings.

2. Select the custom settings group in the Custom Settings box, and click Delete. (You cannot delete any of the predefined settings.)
Your EPSON Stylus Photo 700 lets you print on just about any kind of paper you want to use. You can get great results printing on various sizes of plain paper, letterhead, and envelopes. You'll get even better results with specially coated ink jet paper. For the best output, use EPSON’s Photo Paper or other photo quality media.

For special projects, you can use a variety of EPSON media designed for ink jet printers, ranging from transparencies to iron-on transfer paper. You can even set up your printer to use custom paper sizes to print panoramic images. This chapter covers the following:

- Using special media
- Printing panoramic images and other custom size projects
### Using Special Media

Whether you print on plain paper or special media, you need to load it according to the guidelines in the table below.

<table>
<thead>
<tr>
<th>For this media name...</th>
<th>Load a maximum of this many sheets...</th>
<th>Then select this Media Type setting in your printer software...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper, letter size</td>
<td>100 (load preprinted forms top edge first)</td>
<td>Plain paper</td>
</tr>
<tr>
<td>Plain paper, legal size</td>
<td>100 (pull up the paper support extension)</td>
<td></td>
</tr>
<tr>
<td>Envelopes</td>
<td>10 (set the thickness lever to the + position)</td>
<td></td>
</tr>
<tr>
<td>Labels (single sheets)</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>EPSON 360 dpi Ink Jet Paper</td>
<td>70 letter size 30 legal size</td>
<td>360 dpi Ink Jet Paper</td>
</tr>
<tr>
<td>EPSON Special Coated Paper for 360 dpi Printing</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EPSON Iron-On Cool Peel Transfer Paper¹</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>EPSON High Quality Ink Jet Paper</td>
<td>70 letter size 30 legal size</td>
<td>Photo Quality Ink Jet Paper</td>
</tr>
<tr>
<td>EPSON Photo Quality Ink Jet Paper</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EPSON Special Coated Paper for 720 dpi Printing</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EPSON Photo Quality Ink Jet Cards</td>
<td>30 cards (use a support sheet)</td>
<td></td>
</tr>
<tr>
<td>EPSON Special Coated Index Cards for 720 dpi Printing</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EPSON Photo Quality Self Adhesive Sheets</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>EPSON Photo Quality Glossy Paper</td>
<td>20 (use a support sheet)</td>
<td>Photo Paper</td>
</tr>
<tr>
<td>EPSON Photo Paper</td>
<td>20 (use a support sheet)</td>
<td></td>
</tr>
<tr>
<td>EPSON Panoramic Photo Paper</td>
<td>1</td>
<td></td>
</tr>
</tbody>
</table>
Printing on Special Media

The type of paper or other media you use is one of the most important factors in determining the quality of your printed output. The following tips will help you get the best results on any type of paper or other media.

**Additional Media Loading Guidelines**

- If the corresponding Media Type option for your paper is not shown in the Media Type list, change the Print Quality setting in the More Settings dialog box, select Automatic as the Mode setting, or change the predefined setting in the Custom Settings list in the printer settings dialog box. Then select the correct Media Type. See Chapter 2 for more information.

- In addition to the Media Type option, remember to select the correct Paper Size for your media on the Paper menu.
Printing on Special Media

- Some special media have a cut corner that you need to position correctly; follow any instructions in the package. Always handle sheets by the edges, and don’t touch the printable surface.

- If the special media has protective sheets between the sheets of media, be sure to remove the protective sheets before printing.

- Be sure to load the printable side of the media face up in the sheet feeder.

- Use ink jet papers within one year of purchase. Use glossy media and transparencies within six months. Return unused sheets and envelopes to their original packages as soon as possible. See Appendix B for more media storage information.

- Some media require additional loading instructions. See the following sections for more information about printing on the following media:
  - “Envelopes” on page 3-5
  - “EPSON Photo Quality Ink Jet Cards” on page 3-6
  - “EPSON Photo Paper (4 x 6)” on page 3-6
  - “EPSON Ink Jet Transparencies” on page 3-8
  - “Panoramic Photo Paper and Banners” on page 3-8
Printing on Special Media

Envelopes

You can load up to 10 envelopes at a time. Adjust the left edge guide and load the envelopes as shown, flap edge first and printable side up:

Note:
Before you print, make sure you set the Paper Size option for the type of envelope you’re using. Set the Media Type to Plain paper.

Set the thickness lever to the + position when you print on envelopes or if ink smears when you print on other thick media. Open the printer cover and position the lever as shown below. Then close the cover and print. (Make sure you return the lever to the 0 position before you print on regular media.)
Printing on Special Media

EPSON Photo Quality Ink Jet Cards

Use these cards to print photos, postcards, or greeting cards.

You can load up to 30 cards at a time with the included support sheet or a sheet of plain paper beneath the stack. When you’re ready to print, use your software to set the Paper Size option for the size card you’re using and set the Media Type to Photo Quality Ink Jet Paper.

If ink smears on the cards, set the thickness lever to the + position before printing, as shown on page 3-5.

EPSON Photo Paper (4 × 6)

Photo Paper (4 × 6) is perforated around the edges, so you can trim your printouts and “bleed” the photo—extend it to the edge of the paper—on all sides. Follow these steps to print on EPSON Photo Paper:

1. Load the paper with the glossy side facing up and the perforated margins positioned as shown:

   ![Illustration of Photo Paper loading](image)

   You can load up to 20 sheets of Photo Paper at a time. Make sure you place the included support sheet beneath the stack, but don’t print on it.

2. Slide the left edge guide so it fits snugly against the paper.
Printing on Special Media

3. When you create the image in your application software, size it to 4.25 × 6.25 inches. You can also use proportional printing as described on page 2-21 (Windows) or page 2-28 (Macintosh).

4. Choose EPSON Photo Paper 4 × 6 in as the Paper Size setting and Maximum as the Printable Area setting.

5. Choose Photo Paper as the Media Type setting.

6. After you print your picture, fold the paper back and forth along the perforations and carefully tear the margins off.

To keep your printouts looking their best, store them in a resealable plastic bag or other airtight covering and protect them from heat, humidity, and direct sunlight.
Printing on Special Media

EPSON Ink Jet Transparencies

To print on transparencies only, remove the paper support and reinstall it in the rear paper support slot, as shown below.

Before you load transparencies, place the included support sheet or a plain paper sheet beneath the stack. You can load up to 10 transparencies. However, you may get better results by loading one sheet at a time. With multiple sheets loaded, the minimum top margin you can use is 1.2 inches.

Panoramic Photo Paper and Banners

You can use EPSON Panoramic Photo Paper to print photo-quality images up to 22.5 inches long, or you can use banner paper or ordinary (continuous-form) computer paper to print an image up to 44 inches long. You can also print on any size paper that fits into the printer (at least 3.94 × 3.94 inches), by using the custom page size feature of your printer software on either a Windows computer or a Macintosh.
Loading Panoramic or Banner Paper

1. Pull up the paper support extension and pull out the output tray extensions.

2. To make a 44-inch print with continuous-form computer paper, first tear off four continuous sheets and remove the perforations at the edges. If you are using non-perforated banner paper, cut the paper to the length you want for easier handling.

3. Slide the left edge guide to the far left.

4. Insert the paper in the printer as shown. The right edge of the paper should be against the right edge guide. You can load precut EPSON Panoramic Photo Paper the same way.

5. Slide the left edge guide next to the left edge of the paper.

6. Follow the instructions below to print your image on either a Windows computer or a Macintosh.

Tip: If the paper is not loading correctly, hold the paper straight while pressing the load/eject button to load the sheet in the printer.
Printing a Panoramic Image from Windows

Follow these steps to print a panoramic image or other custom-size project on a Windows computer:

1. Create the project in your graphics application or other software. You can create it in either portrait or landscape orientation.

2. Click the print icon or choose Print or Print Setup from the File menu. You see a printing dialog box.

3. Make sure your printer is selected, and then click the Printer, Setup, Properties, or Options button. (You may have to click a sequence of these buttons.) You see the printer settings dialog box, as shown on page 1-2.

4. Click the Paper tab. You see a dialog box like the following:

5. If you are using precut EPSON Panoramic Photo Paper, choose Panoramic 210 × 594 mm from the Paper Size list. Otherwise, choose User Defined and enter the size of your paper (see page 2-15 for instructions).
Printing on Special Media

6. Choose **Portrait** or **Landscape** if you haven’t already specified the orientation in your application software. Rotate the image 180° or set the printable area if necessary.

7. Click the **Main** tab to return to the Main printer settings dialog box. Make sure you choose the appropriate media type and the other settings you want to use, and then click **OK**.

8. Click **Close**, **OK**, or **Print** to print your image. You may need to click a sequence of these buttons.

Printing a Panoramic Image from a Macintosh

Follow these steps to print a panoramic image or other custom-size project on a Macintosh:

1. Create the document in your graphics application or other software. You can create it in either portrait or landscape orientation.

2. Choose **Page Setup** from the File menu.

   You see a dialog box like the following:

   - **Paper Size**: Select the size of the paper you are using.
   - **Orientation**: Choose **Portrait** or **Landscape**.
   - **Printable Area**: Define the area that will be printed.
   - **Options**: Configure other settings.

   Click to display list of paper sizes
   
   Click to define your own paper size

---

Tip

If you’re using computer paper, choose Plain paper for the Media Type setting. If you’re using coated banner paper, try the Photo Quality Ink Jet Paper setting.
Printing on Special Media

3. Choose Portrait or Landscape, depending on the orientation you want. Rotate the image 180° or set the printable area if necessary.

4. If you are using precut EPSON Panoramic Photo Paper, select Panoramic 210 × 594 mm in the Paper Size box. Then continue with step 9.

5. Click the Customize button. The following dialog box appears:

6. Click the New button. The dialog box changes:

7. Type a name for your custom size in the New Paper Size box.

8. To print a panoramic image, type 8.5 inches for the Width and up to 44 inches for the Height. (This works for both “landscape” and “portrait” style images.) Click OK, then OK again.

9. Choose Print from the File menu or click the print icon in your application. You see a printer settings dialog box like the one shown on page 1-7.

10. Make sure you choose the appropriate media type and the other settings you want to use, and then click Print to print your banner.

Tip

If you’re using computer paper, choose Plain paper for the Media Type setting. If you’re using coated banner paper, try the Photo Quality Ink Jet Paper setting.
Managing Print Jobs

Your printer software includes several utilities for managing print jobs. You can use them to monitor your printer’s status, set up large jobs to print later, and handle network printing.

This chapter provides instructions for the following:

- Managing print jobs in Windows 95
- Managing print jobs in Windows 3.1
- Managing print jobs in Windows NT 4.0
- Managing print jobs on a Macintosh

Managing Print Jobs in Windows 95

Your printer software offers three ways to manage and monitor your print jobs in Windows 95:

- The Progress Meter, which appears each time you send a print job, as described on page 1-6. You can turn the Progress Meter on or off and select other printing options using the **Speed & Progress** button; see page 4-2 for details.
- The Spool Manager, which appears in the taskbar at the bottom of the screen each time you print, as described on page 4-4.
- Status Monitor 2, which provides a variety of print monitoring options, as described on page 4-5.

**Note:**
You can use Status Monitor 2 only if it is installed and your printer is connected directly to the computer or connected to a remote server in a Windows 95 network.
Managing Print Jobs

Selecting the Speed & Progress Options

You can set up the way your printer software sends print jobs and select whether to display the Progress Meter using the Speed & Progress dialog box. To access the dialog box, you must open your printer software from the Windows 95 Printers utility as described below.

1. Click Start, point to Settings, then click Printers.

2. Right-click the EPSON Stylus Photo 700 printer icon and select Properties from the drop-down menu. You see the printer settings dialog box.

3. Click the Utility tab. You see the Utility menu:

![Utility menu screenshot](image)
4. Click the Speed & Progress button. You see this dialog box:

![Speed & Progress dialog box]

Select from the following options:

- **High Speed Copies** speeds up printing of multiple copies of the same document by using your hard disk space as a cache.

- **Show Progress Meter** lets you control whether or not the Progress Meter is displayed when you send a print job. See page 1-6 for information on the Progress Meter.

- **EPSON Printer Port** lets you optimize the transfer rate of your printer port for EPSON printers instead of using the Windows default printer port. You may see one of these messages beneath the **EPSON Printer Port** option:
  - **High speed (DMA) transfer enabled** tells you that you're already using fast DMA transfer mode.
  - **For higher data transfer rates, use DMA transfer** lets you know that you can speed up printing by enabling DMA transfers on your system. See your computer documentation for details.

5. Click OK to close the dialog box and return to the Utility menu. Then click OK again to close the printer software window.
Managing Print Jobs

Using the Spool Manager

The Spool Manager creates a temporary print job file, stores it in the C:\TEMP or C:\WINDOWS\TEMP folder or directory, and assigns it to a print queue. The software then sends the file to your printer at the right time.

To open Spool Manager while you're printing, click the EPSON Stylus Photo 700 icon that appears on the taskbar at the bottom of the screen.

You see the Spool Manager window:

The Spool Manager window displays the status of your print job files and lets you control them. To cancel, pause, resume, or restart a print job, click the job to highlight it; then click one of the command buttons on the bottom of the window.

Deleting a Stalled Print Job

If you’re having trouble printing, it may be because of a stalled print job. Follow these steps to delete the stalled job and continue printing:

1. Click the EPSON Stylus Photo 700 button on the taskbar.

2. Click on any print jobs marked Held.

3. Click the Cancel button.

4. Exit the Spool Manager and try printing again.
Managing Print Jobs

Using Status Monitor 2

Status Monitor 2 lets you view detailed information about your print jobs and control how you want printing monitored. You can check printer status when your printer is connected directly to your computer or if it is connected to a remote server in a Windows 95 network. Before using Status Monitor 2, you must enable background monitoring, as described in the next section.

Enabling Background Monitoring

You can enable background monitoring for your printer if you want Status Monitor 2 to alert you to any error conditions while you’re working on other tasks. This lets you know if paper has run out, or if any other printing problem has occurred, without having to open Status Monitor 2.

To turn on background monitoring, follow these steps:

1. Click Start, point to Programs, point to the Epson folder, and click EPSON Status Monitor 2 to open Status Monitor 2.
2. Click the name of the printer you want to monitor in the Installed Printers list. The printer name is highlighted.
3. Open the Settings menu and select Background Monitoring.
4. Select either Monitor from restart (to begin background monitoring after your next system restart) or Monitor now (to begin background monitoring right away).

Now set your monitoring preferences for the printer as described in the next section.

Note:
ScanDisk will not run if Status Monitor 2 is performing background monitoring. To disable background monitoring, right-click the icon on the Windows 95 taskbar in the bottom right corner of your screen and select Stop monitoring now.
Managing Print Jobs

Setting Up Monitoring Preferences

You can select the way you want Status Monitor 2 to monitor each printer you use in the Monitoring Preferences window. There are several ways to open the window:

- Click the printer name in the Installed Printers list to highlight it and click the icon or select Monitoring Preferences from the Settings menu.
- Right-click the printer name in the Installed Printers list and select Monitoring Preferences from the drop-down menu.

You see the Monitoring Preferences window:

If you turn on one or more of the Status Alert options, you'll see the Status Alert dialog box when the selected condition occurs. For example, if you turn on Show when errors occur, the dialog box will appear only if a printing error occurs. If you select all the options, the dialog box will appear whenever you print, encounter an error, or have low ink levels.

Note:
Background monitoring must be turned on to change the Background Monitoring and Status Alert preferences for individual printers in the Monitoring Preferences window. See page 4-5 for instructions.

Note:
Short monitoring intervals may cause some applications to run slower.
Managing Print Jobs

The color of the printer icon in the Status Alert dialog box indicates the type of error, as described on page 4-8.

Using the Status Monitor 2 Main Window

Once you've enabled background monitoring for your printer and set preferences, there are several ways to access Status Monitor 2:

- Double-click the icon on the Windows 95 taskbar in the bottom right corner of your screen.
- Click Start, point to Programs, click the Epson folder, and click EPSON Status Monitor 2.
- Access the printer software from within your application or the Printers utility (see page 1-2 and page 1-5), click the Utility tab, and click the EPSON Status Monitor 2 button. (This method accesses the Printer Status window only; see page 4-8 for details.)

When you start Status Monitor 2, you see the main window:
Managing Print Jobs

If you have more than one printer you want to monitor, you can add them using the Add Printer option in the Settings menu. To save system resources, you may want to delete any printers from the Status Monitor 2 list that you don’t need to monitor. To do this, click the printer in the Installed Printers list and select Delete Printer from the Settings menu.

The color of the Installed Printer icon indicates the printer status as follows:

<table>
<thead>
<tr>
<th>Installed Printer icon color</th>
<th>Status message</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Ready to print.</td>
</tr>
<tr>
<td>Yellow</td>
<td>Paper and/or ink level is low.</td>
</tr>
<tr>
<td>Red</td>
<td>Paper and/or ink is out, paper is jammed, or a print or communication error has occurred.</td>
</tr>
<tr>
<td>Gray</td>
<td>Printer not detected.</td>
</tr>
</tbody>
</table>

Other options in Status Monitor 2 let you view more details of the printer or job status, as described in the next sections.

Using the Printer Status Window

For more details on the status of your printer, you can use the Printer Status window. There are several ways to open the window:

- Double-click the printer name in the Installed Printers list.
- Click the printer name in the Installed Printers list to highlight it and click the Printer Status icon or select Printer Status from the Printer menu.
- Right-click the printer name in the Installed Printers list and select Printer Status from the drop-down menu.

Tip

You can customize the appearance of items on the Status Monitor 2 main window using the View menu options or options on the button bar.

If you’re monitoring multiple printers, you can reorder them in the Installed Printers list by clicking in the Printer Name, Status, or Job Count title bar.
Managing Print Jobs

- If you’re currently using the printer software, click the Utility tab, then click the EPSON Status Monitor 2 icon. (For instructions on accessing your printer software, see page 1-2 and page 1-5.)

- You can also access the Printer Status window by clicking the Detail button on the Progress Meter (see page 1-6) or the Status Alert dialog box (see page 4-6).

You see the Printer Status window. The Current Status tab gives printing status and error correction information.

To check the amount of ink you have, click the Consumables tab.

The Printer Information tab is not active with this printer.
Managing Print Jobs

Using the Job Status Window

To view detailed information on the print jobs waiting to print on your printer, you can use the Job Status window. There are several ways to open the window:

- Click the printer name in the Installed Printers list to highlight it and click the icon or select Job Status from the Printer menu.
- Right-click the printer name in the Installed Printers list and select Job Status from the drop-down menu.

You see the Job Status window:

Options in the Printer menu let you pause printing or purge all print jobs for the printer, select or deselect the printer as your Windows default, and access the printer software to change default settings.

The Document menu options let you pause or cancel printing of individual printing jobs. First click the print job you want to pause or cancel in the Document Name list to highlight it.

Note:
The Job Status window is very similar to the Spool Manager window. Both allow you to pause, cancel, and restart print jobs. See page 4-4 for information on the Spool Manager.
Managing Print Jobs in Windows 3.1

Your Windows printer software includes two management utilities: the Spool Manager and Despooler.

- The Spool Manager starts automatically when you send a job to the printer. It allows you to print in the background while you continue to work on your computer and to hold jobs to print at a later time. If you're using your printer on a network, it also handles multiple print jobs that come in at the same time. See the next section for details.

- The Despooler also starts automatically when you send a job to the printer. It displays on your screen to show printer status, as described on page 1-7.

Using the Spool Manager

The Spool Manager works like the Windows Print Manager. When you send a job to your printer, your printer software creates a temporary journal file, stores it in the C: \ TEMP or C: \ WINDOWS \ TEMP folder or directory, and assigns it to a print queue. The software then sends the file to your printer at the right time.

- To open it while you're printing, click the Spool Manager icon that appears at the bottom of your desktop.

- You can open the Spool Manager at any time by double-clicking the Spool Manager icon in the EPSON program group.

You see the Spool Manager window:
Managing Print Jobs

The Spool Manager window displays the status of your print queues and journal files and lets you control them. You can also control the display of the Despooler and the default spool directory. Click Help in the Spool Manager menu bar for detailed information.

Deleting a Stalled Print Job

If you’re having trouble printing, it may be because of a stalled print job. Follow these steps to delete it and continue printing:

1. Open the Spool Manager as described above.
2. Click on any print jobs marked Held, then open the Document menu and click Delete.
3. Click Yes.
4. Exit Spool Manager and try printing again.

Changing the Default Spool Directory

If you get an error message when you try to print, or printing is very slow, you can try changing your default spool directory.

1. Make a directory on your hard disk where you want Spool Manager to store print job files, for example, C:\SPLTEMP.
2. Open the Spool Manager as described on page 4-11.
3. Choose Default Spool Directory from the Options menu.
4. In the dialog box, change the spool directory to the one you created in step 1. Then click OK.
5. Make sure EPSON Stylus Photo 700 is selected, and then choose Setup from the Queue menu. The Queue Setup dialog box appears.
Managing Print Jobs

6. Make sure the spool directory is the one you created in step 1. Also make sure Use Print Manager for this port is checked. Then click OK.

7. Close Spool Manager.

Managing Print Jobs in Windows NT 4.0

Windows NT 4.0 servers and workstations include a messenger service to alert you to printer errors or let you know when a print job is finished. If you have appropriate network access privileges or you’re controlling printing from the server, you can also cancel, pause, or restart print jobs and set the sharing, security, scheduling, and port options. See your Windows NT documentation for details.

Managing Print Jobs on a Macintosh

Your Macintosh printer software includes two management utilities: Monitor3 and Status Monitor. It also includes a Configuration utility for setting up print monitoring options.

- If you’re using background printing, Monitor3 starts automatically when you send a job to the printer. It handles printing while you continue to work on your Macintosh and lets you track documents that are waiting to be printed.

- The Status Monitor shows you see how much ink you have left.

- The Configuration utility lets you select how you’ll be notified of printer errors and where you want print job files stored.
Managing Print Jobs

Using Monitor3

The Monitor3 utility lets you continue to work on your Macintosh while your document is printing. You can use Monitor3 to check or cancel any pending print jobs. It also shows the status of the job currently being printed.

If you want to use this utility, you need to turn on background printing in the Chooser and increase the memory allocation for Monitor3, as described in the next section.

Setting Up Monitor3

1. Open the Chooser from the Apple menu and select the SP 700 icon. Then select the port you are using.

2. Under Background Printing, click On and close the Chooser.

3. To increase the memory allocated to Monitor3, select EPSON Monitor3 in the Extensions folder in your System folder.

4. Choose Get Info from the File menu.

5. Under Memory Requirements, set the Preferred Size to 3000.
Managing Print Jobs

Monitoring Print Jobs with Monitor3

While you’rerprinting, click the EPSON Monitor3 icon on the Application menu at the right end of the menu bar. You see a dialog box like the following:

From this dialog box, you can pause, restart, and cancel print jobs. You can also prioritize print jobs by following these steps:

1. Click the Show details arrow at the bottom of the dialog box. You see an extended dialog box similar to the one below.

2. Select the document you wish to prioritize.

3. Select Urgent, Normal, or Hold from the Priority list. The document moves up or down in the waiting print jobs list.
Managing Print Jobs

Using the Macintosh Status Monitor

You can use the Status Monitor to check the level of ink in your printer. Follow these steps:

1. Choose Page Setup or Print from the File menu or click the print icon in your application.

2. Click the Utility button. You see the Utility menu:

3. Click the EPSON StatusMonitor button. The software checks the amount of ink remaining in the printer and displays the Status Monitor window:
Managing Print Jobs

Selecting Configuration Options

You can configure the way you want the printer to handle error messages, warnings, and ink level checks and set up temporary spool folders on the Configuration Settings dialog box. Follow these steps:

1. Choose Page Setup or Print from the File menu in your application. You see a printer settings dialog box.

2. Click the Utility button. You see the Utility menu.

3. Click the Configuration button. You see the Configuration Settings dialog box:

4. Choose the options you want and click OK.
5

Maintenance and Transportation

It’s easy to keep your EPSON Stylus Photo 700 printer working at its best. All you have to do is follow the simple instructions in this chapter for replacing ink cartridges, moving the printer, and performing routine maintenance.

This chapter covers the following procedures:

- Cleaning the print head
- Replacing an ink cartridge
- Aligning the print head
- Cleaning the printer
- Transporting the printer

Cleaning the Print Head

If your printed image is unexpectedly light or faint, or dots are missing from the image, you may need to clean the print head. This unclogs the print head nozzles so they can deliver ink properly.

Cleaning the print head uses ink, so clean it only if print quality declines. You can use either of the following to clean the print head:

- The Head Cleaning utility (recommended) in your printer software (if the printer is on a local port, not on a network)
- The printer’s control panel buttons

Caution:
Don’t use the cleaning sheets that may be included with your special media; they may damage the printer.
Using the Head Cleaning Utility

Follow these steps to run the utility:

1. Make sure the printer is turned on but not printing, and that the black and color ink out lights are off.

2. Access the printer settings dialog box as described in Chapter 1.

3. Click the Utility tab (Windows) or the Utility button (Macintosh). You see the Utility menu.

4. Click the Head Cleaning button.

5. Follow the instructions on the screen to clean the print head. Cleaning takes about two minutes, during which the printer makes some noise and the power light flashes. When the power light stops flashing, you need to run a nozzle check to confirm that the print head nozzles are clean and to reset the printer’s cleaning cycle.

6. Make sure paper is loaded in the printer and click Print nozzle check pattern (Windows) or Confirmation (Macintosh). Then click Next. See page 5-4 for instructions on examining the nozzle check pattern.

If your print quality has not improved, repeat the steps above. If you don’t notice any improvement after doing this two or three times, check the print quality solutions in Chapter 6.

Caution: Never turn off the printer while the power light is flashing, unless the printer hasn’t moved or made any noise for more than 5 minutes.
Using the Control Panel

Follow these steps to clean the print head:

1. Make sure the printer is turned on and not printing, and that the black and color ink out lights are off.

2. Press the cleaning button and hold it down for three seconds. Cleaning takes about two minutes, during which the printer makes some noise and the power light flashes.

   After the cleaning cycle is complete and the power light stops flashing, you need to run a nozzle check to confirm that the print head nozzles are clean and to reset the printer’s cleaning cycle.

3. Access the printer settings dialog box as described in Chapter 1.

4. Click the Utility tab (Windows) or the Utility button (Macintosh). You see the Utility menu.

5. Click the Nozzle Check button. Then click Next. See the next section for instructions on examining the nozzle check pattern.

If your print quality has not improved, repeat the steps above. If you don’t notice any improvement after doing this two or three times, check the print quality solutions in Chapter 6.
Examining the Nozzle Check Pattern

Examine the nozzle check pattern after printing it. It should look something like this, with each of the six sections showing one of the ink colors:

Each staggered horizontal and straight vertical line should be complete, with no gaps in the dot pattern. If your printout looks okay, you’re done. If any dots are missing, as shown below, clean the print head again, as explained in the previous sections.

Replacing an Ink Cartridge

When a black or color ink out light flashes, the indicated cartridge is low on ink. This is a good time to make sure you have a new cartridge. When the light stays on, the cartridge is empty and you need to replace it. You cannot print if either ink cartridge is empty. You can also check your ink levels using the Status Monitor. See page 4-8 (Windows 95) or page 4-16 (Macintosh) for details.

Use these EPSON ink cartridges within six months of installing them and before the expiration date on the package:

- Black ink cartridge: S020093
- Color ink cartridge: S020110

When you need new ink cartridges, contact your dealer or call EPSON Accessories at (800) 873-7766 (U.S. only). In Canada, please call (800) 873-7766 for dealer referral.
Removing an Empty Ink Cartridge

You can replace a cartridge when the black or color ink out light is either flashing or on. Follow these steps:

1. Make sure the printer is turned on and not printing.
2. Determine which cartridge needs to be replaced.
3. Lower the output tray and raise the printer cover.
4. Press the cleaning button and hold it for three seconds.
   The print head moves slightly to the left and the power light begins flashing. (The print head returns to its home position if you don’t proceed to step 5 within 60 seconds.)
5. Pull up the ink cartridge clamp. The cartridge rises up from its holder. (Although the illustration shows the color ink cartridge, the procedure is the same for replacing the black ink cartridge.)
6. Lift the cartridge out of the printer and dispose of it carefully.
7. Follow the steps in the next section to install the new ink cartridge.

Note:
If you press the cleaning button when neither ink out light is flashing or on, the printer cleans the print head as described on page 5-2. If you need to replace an ink cartridge before the lights flash (because the ink is too old, for example) follow the instructions on page 5-7.

Caution:
To avoid damaging the printer, never move the print head by hand.

Don’t open the clamp or remove a cartridge except to replace it with a new one. Once you remove a cartridge, you can’t reuse it. Even if the cartridge contains ink, reusing it may damage the print head.
Installing the New Cartridge

Once you have removed the empty cartridge, you’re ready to install the new one. Follow these steps:

1. Remove the new ink cartridge from its packaging.

2. Remove only the yellow part of the tape seal on the top of the cartridge. Do not remove the white part. (It’s OK if the tape does not tear off exactly along the dotted line.)

3. Lower the ink cartridge into its holder with the label facing up and the arrow pointing to the back of the printer. The larger cartridge (color) goes on the right, the black ink cartridge on the left.

Caution:
You must remove only the yellow tape seal from the top of the cartridge; leaving the tape on will permanently damage it. Do not remove the clear seal from the bottom of the cartridge; ink will leak.

Warning:
If ink gets on your hands, wash them thoroughly with soap and water. If ink gets into your eyes, flush them immediately with water.
4. Press down the ink cartridge clamp until it locks in place.

5. If you need to replace the other ink cartridge, remove it as described in “Removing an Empty Ink Cartridge” on page 5-5. Then follow steps 1 through 4 in this section.

6. Press the \textit{R} cleaning button and close the printer cover.

   The printer moves the print head and begins charging the ink delivery system. (Even if you don’t press the button, ink charging begins 60 seconds after you close the clamp.)

   The \textit{P} power light flashes and the printer makes various sounds. Charging takes about two minutes. When it’s finished, you can print again.

\textbf{Replacing an Outdated Ink Cartridge}

If an ink cartridge is more than six months old, you may need to replace it. How can you tell? You may notice that your printouts don’t look as good as they used to. If print quality doesn’t improve after cleaning and aligning the print head, you can replace one or both cartridges.
Maintenance and Transportation

Follow these steps to replace an ink cartridge before the black or color ink out light is flashing or on:

1. Make sure the printer is turned on and not printing.
2. Lower the output tray and raise the printer cover.
3. Press the load/eject button and hold it down for a few seconds until the print head moves to the left. (The printer automatically moves the print head back to the home position after 60 seconds if you don’t continue with step 4.)
4. Pull up the ink cartridge clamp. The cartridge rises up from its holder.
5. Lift the cartridge out of the printer and dispose of it carefully.
6. Follow the steps in the previous section, “Installing the New Cartridge,” to install the new ink cartridge.

Aligning the Print Head

If your printouts contain misaligned vertical lines, you may need to align the print head. Follow these steps:

1. Make sure the printer is turned on and paper is loaded.
2. Access the printer settings dialog box as described in Chapter 1.
3. Click the Utility tab (Windows) or the Utility button (Macintosh). You see the Utility menu.
4. Click the Print Head Alignment button.
5. Follow the instructions on the screen to print a test page and select the correct alignment.

Caution:
To avoid damaging the printer, never move the print head by hand.

For best results, use EPSON ink jet paper or photo quality paper whenever you check the print head alignment.
Maintenance and Transportation

Cleaning the Printer

To keep your printer working at its best, you should clean it several times a year, following these steps:

1. Turn off the printer, unplug the power cord, and disconnect the printer cable.

2. Remove all the paper from the sheet feeder.

3. Clean the exterior of the printer with a soft, damp cloth. Keep the printer cover closed so water doesn’t get inside.

4. Clean ink out of the printer’s interior with a damp cloth.

Transporting the Printer

If you want to move your printer some distance, you need to prepare it for transportation and repack it in the original box. Follow these steps:

1. Turn on the printer and wait until the print head locks in the far right position. Then turn off the printer.

2. Unplug the power cord from the electrical outlet. Then disconnect the interface cable from the printer.

3. Remove any paper from the sheet feeder and remove the paper support.

4. Push in the output tray extensions and close the tray.

5. Repack the printer and attachments in the original box using the protective materials that came with it. See the Notice Sheet that was packed with the printer.

Be sure to keep the printer flat as you transport it. If you notice a decline in print quality after transporting the printer, clean the print head; if output is misaligned, align the print head. See the instructions in this chapter.
As you use your printer, you may occasionally experience a paper jam or other problem. The first thing you should do is diagnose the problem, following the guidelines in this chapter. Then try the most likely solutions until the problem is fixed.

This chapter tells you everything you need to know about the following:

- Diagnosing problems
- Improving print quality
- Solving printing problems
- Solving printer software problems
- Fixing paper jams and other paper problems
- Solving miscellaneous printout problems

### Diagnosing Problems

Your printer includes a number of ways to help you diagnose problems:

- To identify the most common problems, check the lights on the printer’s control panel. See “Checking the Control Panel Lights” in the next section.

- You can also use the Status Monitor utility to identify common problems. For instructions, see page 4-5 (Windows 95) or page 4-16 (Macintosh).
Troubleshooting

To determine whether the problem is caused by the printer itself, run a printer operation check. See “Running a Printer Check” on page 6-3 for instructions.

For the latest information, check the EPSON Stylus Photo and Status Monitor Help programs and ReadMe files in the EPSON program group or folder.

There are additional troubleshooting tips in the “Problems, Need Help” section of your Getting Started guide.

If none of the suggested solutions in this chapter solve your problem, contact EPSON as described under “Where To Get Help” in the Introduction.

Checking the Control Panel Lights

The four lights on your printer’s control panel show the printer’s status and alert you to problems like paper jams.

- When the paper out light comes on, your paper ran out or is incorrectly loaded. Load paper in the sheet feeder and then press the load/eject button.

- When the paper out light flashes, you have a paper jam. Take all of the paper out of the sheet feeder, reload the paper, then press the load/eject button. If the light continues to flash, turn off the printer and gently pull out any jammed paper.

- When an ink out light flashes, your ink supply is low. Make sure you have a replacement cartridge.
Running a Printer Check

You can run a printer check to determine whether the problem comes from the printer itself or some other source.

- If the results are satisfactory, the problem lies in software settings, the interface cable, or your computer.
- If the printer check does not print correctly, there is a problem with your printer. See the suggestions in this chapter for possible solutions.

Follow these steps to check the printer:

1. Make sure both the printer and computer are turned off.
2. Disconnect the interface cable from the printer.
3. Make sure paper is loaded in the printer.
4. Hold down the † load/eject button and press the  power button. Hold down the buttons until the  power light starts to flash. Then release both buttons.
Troubleshooting

The printer prints one page containing the printer’s ROM version, ink counter code, character table number, and a nozzle check pattern. Only the nozzle check pattern is shown below:

5. After it prints the page, turn off the printer. Remember to reconnect the interface cable, then turn on the printer and your computer.

Using the Printer and Option Information Utility

If you are running Windows 95 or Windows NT 4.0, you can use the Printer and Option Information utility to confirm printer configuration information. Color quality may improve after confirming the printer configuration information.

If you are running Status Monitor 2 (Windows 95 only), the printer configuration information is updated automatically. Under certain circumstances, you may need to input some information manually. If a message appears in the Current Settings window prompting you to enter settings or if you change the printer’s configuration, follow the steps below to make the necessary settings manually:

1. Make sure letter size paper is loaded in your printer.

2. In the printer settings window, click the Utilities tab, then click the Printer and Option Information icon.

3. Click the Settings Sheet button. You see a printout similar to the one below:

   \[
   \text{Printer ID} \\
   50- 50- 50- 50- 50- 50
   \]
4. Make sure the settings in the utility match the information on the printed Settings Sheet. If they do not match, correct the settings on the screen to match the information on the settings sheet.

5. Click OK to exit and save your settings.

Uninstalling Printer Software

If any of the suggested solutions in this chapter tell you to uninstall and then reinstall your printer software, follow the steps in this section.

Windows 95 Instructions

1. Double-click the My Computer icon, then double-click the Control Panel icon.
2. Double-click Add/Remove Programs.
3. To uninstall the printer software, select EPSON Printer Software in the program list.
   
   To uninstall Status Monitor 2, select EPSON Status Monitor 2 in the program list. Background monitoring must be turned off before removing Status Monitor 2.
4. Click the Add/Remove button. Follow the instructions on the screen to uninstall your software.
5. Restart your computer.
6. To reinstall your software, see the Getting Started guide.

Note:
In Windows NT 4.0, you cannot uninstall the printer software using the Add/Remove Programs utility. See the EPSON Stylus ReadMe file in your EPSON Printer program group for uninstall instructions.
Troubleshooting

Windows 3.1 Instructions

1. Double-click the Main program group icon, then double-click the Control Panel icon.

2. Double-click Printers.

3. Select EPSON Stylus Photo 700 in the Installed Printers list and click the Remove button.

4. To reinstall your software, see the Getting Started guide.

Macintosh Instructions

1. Insert the EPSON printer software CD-ROM in your drive.

2. Double-click the Installer icon. Then click Continue.

3. Click the arrow in the list at the top showing Easy Install, and select Remove from the list.

4. Click the Remove button at the bottom of the screen.

5. Follow the instructions on the screen to uninstall the printer software.

6. To reinstall your software, see your Getting Started guide.
Improving Print Quality

You can often improve print quality by doing one of the following:

- Clean the print head; the print head nozzles may be clogged (see page 5-1 for instructions).
- Use higher quality paper appropriate for your print job (see page 3-2 for a list of EPSON papers).
- Match the Media Type setting in the printer settings dialog box to the type of media you loaded in the printer. Then the printer software can automatically select other settings for the best quality (see Chapters 1 and 3 for details).
- Turn off High Speed mode (see page 2-4 for details).
- Turn off Economy mode (see page 2-4 for details).
- Replace the ink cartridges. If an ink cartridge is low on ink (the black or color ink out light is flashing) or the ink cartridge is more than six months old, the cartridge should be replaced. See page 5-4 for instructions.
- If you have vertical misalignment, run the Print Head Alignment utility (see page 5-8 for instructions) or turn off High Speed mode.

Try the solutions listed above before trying these solutions to specific print quality problems.

The printed image has horizontal banding

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The printable side of the paper is face down.</td>
<td>Remove the paper and reload it with the printable side face up. See page 3-3 for instructions.</td>
</tr>
<tr>
<td>The MicroWeave (or Super MicroWeave) option is not set.</td>
<td>Turn on MicroWeave (or Super MicroWeave) in the More Settings dialog box. See page 2-4 for more information.</td>
</tr>
</tbody>
</table>
Troubleshooting

The printed image has incorrect or missing colors

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Ink option is set to Black.</td>
<td>Change the Ink setting to Color. See page 1-2 (Windows) or page 1-7 (Macintosh) for instructions.</td>
</tr>
<tr>
<td>The printable side of the paper is face down.</td>
<td>Remove the paper and reload it with the printable side face up. See page 3-3 for instructions.</td>
</tr>
<tr>
<td>The Halftoning and Color Adjustment Mode options are set incorrectly for your document type.</td>
<td>Use the correct settings for the project you’re printing, following the instructions on page 2-2 and page 2-4.</td>
</tr>
<tr>
<td>The ICM (Windows 95) or ColorSync (Macintosh) settings are incorrect for your document.</td>
<td>Use the Automatic mode setting or choose a different project type or Rendering Intent setting (Macintosh). See Chapter 2 for more information.</td>
</tr>
<tr>
<td>The ink cartridges are low on ink or one or more ink colors are empty.</td>
<td>Check the black and color ink out lights to see which cartridge you may need to replace. See page 5-4 for instructions.</td>
</tr>
<tr>
<td>The colors displayed on your monitor don’t match the printed colors.</td>
<td>Because your monitor and printer use different technologies to represent colors, your printed colors cannot exactly match the colors you see on your monitor screen. Use the ICM (Windows 95) or ColorSync (Macintosh) settings. See page 2-4 and page 2-8 for more information.</td>
</tr>
<tr>
<td>The color settings in your application software need adjustment.</td>
<td>You may be able to adjust various color settings in your application software. See your software documentation for more information.</td>
</tr>
</tbody>
</table>

The printed image is blurry or smeared

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The loaded paper is damaged, old, or dirty.</td>
<td>Remove the paper and reload a new stack with the printable side face up. See page 3-3 for instructions.</td>
</tr>
<tr>
<td>The printer’s thickness lever is in the 0 position.</td>
<td>Set the thickness lever to the + position and try printing again. See page 3-5 for instructions.</td>
</tr>
<tr>
<td>The paper is damp or the printable side is face down.</td>
<td>Remove the paper and reload a new stack with the printable side face up. See page 3-3 for instructions.</td>
</tr>
<tr>
<td>You loaded special media without a support sheet.</td>
<td>Follow the special media loading instructions on page 3-2 and on the paper packaging for media that require support sheets. Also try loading your media one sheet at a time.</td>
</tr>
</tbody>
</table>
Troubleshooting

**Color documents print in black and white**

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>You tried to print on cardboard or other non-recommended media.</td>
<td>Make sure your paper or media meets the specifications listed in Appendix B. If your printouts are still blurry after you change paper, clean the print heads as described on page 5-1.</td>
</tr>
<tr>
<td>Ink has leaked inside the printer.</td>
<td>Clean carefully inside the printer to remove spilled ink. See page 5-9 for instructions.</td>
</tr>
</tbody>
</table>

**Solving Printing Problems**

If the printer won’t print, first check that:

- The printer is turned on and the ∅ power light is on, but not flashing.
- Paper is loaded in the printer.
- The printer is plugged into a working electrical outlet that’s not controlled by a switch or timer.
- The interface cable is securely connected to the printer and computer and both are turned on.

If you still can’t print, check the following solutions.

**All lights are off**

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The printer is not receiving power.</td>
<td>Try these solutions:</td>
</tr>
<tr>
<td></td>
<td>- Make sure the printer is turned on.</td>
</tr>
<tr>
<td></td>
<td>- Turn off the power and plug in the power cord securely.</td>
</tr>
<tr>
<td></td>
<td>- Try using another power outlet.</td>
</tr>
</tbody>
</table>
Troubleshooting

**Only the ⚫️ power light is on, but nothing prints**

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The interface cable is not connected securely.</td>
<td>Turn off your printer and computer. Then make sure the cable is connected securely and meets the printer's specifications. (Use a fully shielded IEEE parallel cable on a PC or a Macintosh serial cable.)</td>
</tr>
<tr>
<td>The printer has an internal problem.</td>
<td>Turn off the printer and computer, disconnect the interface cable, and run a printer check as described on page 6-3.</td>
</tr>
<tr>
<td>Your printer software or application software is installed incorrectly.</td>
<td>If you ran a printer check successfully, make sure your printer and application software are installed correctly. If you’re printing on a network, you may need to set up your printer for network printing, as described in Appendix A.</td>
</tr>
</tbody>
</table>
| Your computer doesn’t have enough memory to handle the data in the file you are printing. | Try one of the following:  
  - Reduce the resolution of your image.  
  - Select fewer colors or a lower resolution for your monitor.  
  - Add more memory to your computer. |
| Printing is stalled.                                                           | In Windows, delete the stalled print jobs in Spool Manager; see page 4-4 for instructions.                                                                 |
|                                                                              | On a Macintosh, delete stalled print jobs using EPSON Monitor3 (see page 4-15) or open the Extensions folder, EPSON folder, and Spool folder, and then delete any queued files. |
| Your printer can’t use the modem port (Macintosh).                           | If your Macintosh has a built-in modem, connect the printer to the printer port.                                                            |

**The printer sounds as though it is printing, but nothing prints**

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The print head nozzles are clogged.</td>
<td>Clean the print head nozzles; see page 5-1 for instructions. If this does not work after two or three times, see below.</td>
</tr>
<tr>
<td>One or both of the ink cartridges are too old.</td>
<td>Try cleaning the print head. If that doesn’t work, replace the ink cartridges as described on page 5-7.</td>
</tr>
</tbody>
</table>

**The ⚫️ paper out light is flashing or on**

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>If flashing, paper is jammed.</td>
<td>Remove the paper and follow the guidelines for preventing jams on page 6-15.</td>
</tr>
<tr>
<td>If on, paper is used up or loaded incorrectly.</td>
<td>Load paper or remove the stack and reload it as described in the Getting Started guide or page 3-3. Then press the load/eject button to turn off the light and resume printing.</td>
</tr>
</tbody>
</table>
### A ⚫ black or ✗ color ink out light is flashing or on

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>If flashing, the ink supply is getting low.</td>
<td>You need to replace the indicated ink cartridge soon. Make sure you have a new cartridge, then see page 5-4 for instructions.</td>
</tr>
<tr>
<td>If on, the ink cartridge is empty.</td>
<td>You must replace the indicated ink cartridge; see page 5-4 for instructions.</td>
</tr>
</tbody>
</table>

### The ⚫ and ⬤ lights are flashing

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>A carriage error has occurred.</td>
<td>Remove any paper in the printer. Press the load/eject button for about 30 seconds. Then press it again. Turn the printer off, wait a few seconds, and then turn it on and try printing again. If the error is not cleared, contact EPSON as described in the Introduction.</td>
</tr>
</tbody>
</table>

### All the lights are flashing

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>You haven’t removed all the packing material from the printer.</td>
<td>Remove the packing material, following the instructions on the Notice Sheet in the box.</td>
</tr>
<tr>
<td>An internal error may have occurred.</td>
<td>Turn off your printer, wait a few seconds, and turn it on again. If the lights still flash or stay on, contact EPSON as described in the Introduction.</td>
</tr>
</tbody>
</table>

### The printer has finished charging the ink cartridge, but the ⬤ power light is still flashing

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The ink cartridge clamp isn’t locked down.</td>
<td>Press down on the clamp to lock it into place.</td>
</tr>
<tr>
<td>Packing material remains in the printer.</td>
<td>Remove the packing material, following the instructions on the Notice Sheet in the box.</td>
</tr>
<tr>
<td>The printer needs to initialize.</td>
<td>If the printer is not moving or making noise, but the light is still flashing after 5 minutes have passed, turn the printer off. If the light is still flashing when you turn it back on, contact EPSON as described in the Introduction.</td>
</tr>
<tr>
<td>The printer may be receiving data from the computer.</td>
<td>Turn the printer and computer off. Disconnect the printer from the computer. Turn the printer on. If the light continues to flash for more than 5 minutes, contact EPSON as described in the Introduction.</td>
</tr>
</tbody>
</table>
Troubleshooting

Solving Printer Software Problems

If you have trouble with your printer software, first check that your printer is selected as the default Windows printer or as the current printer in the Macintosh Chooser; see your Getting Started guide.

If you still have problems with your printer software, check the following solutions. If you need to uninstall the printer software, see page 6-5.

After you install your printer software, you see the Windows 95 New Hardware Found window

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>An operating system error has occurred.</td>
<td>Click Do not install a driver, and then click OK. Never select any other option on the New Hardware Found window.</td>
</tr>
</tbody>
</table>

In Windows 95, the Status Monitor 2 window doesn’t appear

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>You may not have restarted your computer after installing Status Monitor 2.</td>
<td>Click Start, select Shut Down, click Restart the computer, and click Yes to restart your computer. Then try using Status Monitor 2.</td>
</tr>
<tr>
<td>Bi-directional support is not enabled.</td>
<td>Make sure your printer is connected to your computer with a bi-directional cable. Then click Start, select Settings, and click Printers. Right-click the EPSON Stylus Photo 700 icon and select Properties. Click the Details tab, then click the Spool Settings button. Click the Enable bi-directional support for this printer radio button to turn on bi-directional support. Click OK twice, then close the Printers window and try printing again.</td>
</tr>
</tbody>
</table>

After you install your printer software, you can’t run ScanDisk (Windows 95)

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>You cannot use ScanDisk if Status Monitor 2 is active.</td>
<td>Disable Status Monitor 2 whenever you want to run ScanDisk. See page 4-5 for details.</td>
</tr>
</tbody>
</table>
## Troubleshooting

### You see a spooling error message (Windows)

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spooling error messages or very slow printing may be caused by temporary files.</td>
<td>Change the Spool Manager default spool directory, following the instructions on page 4-12.</td>
</tr>
<tr>
<td>Your hard drive is too full.</td>
<td>Delete unnecessary files to make room on the drive.</td>
</tr>
<tr>
<td>Your computer doesn’t have enough memory for the file you’re printing.</td>
<td>Try one of the following:</td>
</tr>
<tr>
<td></td>
<td>◗ Reduce the resolution of your image.</td>
</tr>
<tr>
<td></td>
<td>◗ Select fewer colors or a lower resolution for your monitor.</td>
</tr>
<tr>
<td></td>
<td>◗ Add more memory to your computer.</td>
</tr>
</tbody>
</table>

### You see a type 11 or memory error message (Macintosh)

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>You may need to increase the memory allocation for your application, EPSON Monitor3, or both.</td>
<td>Choose Get Info from the File menu when your application is active or EPSON Monitor3 is selected and increase the memory requirements. See page 4-14 for more information. If this doesn’t work, turn off background printing (you won’t be able to use EPSON Monitor3).</td>
</tr>
<tr>
<td>Your system doesn’t have enough RAM.</td>
<td>If your system has virtual memory, use this to simulate having more RAM. If this doesn’t work, free up more space on your hard drive by deleting unwanted files. See your computer documentation for details.</td>
</tr>
</tbody>
</table>

### Your printer switches to the modem port or won’t confirm on the printer port (Macintosh)

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Your system has extension conflicts.</td>
<td>Make sure AppleTalk® is inactive. In the Chooser, set any Apple serial printer to the printer port. Close and reopen the Chooser; then select the SP 700 icon. Close the Chooser.</td>
</tr>
<tr>
<td>You’re using an AppleTalk cable.</td>
<td>Make sure you’re using a standard Apple System Peripheral-8 cable, and it’s securely connected at both ends.</td>
</tr>
</tbody>
</table>

### You are unable to use EPSON Monitor3 (Macintosh)

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>EPSON Monitor3 is not installed or is corrupted.</td>
<td>Install (or reinstall) EPSON Monitor3 and make sure background printing is turned on.</td>
</tr>
</tbody>
</table>
Troubleshooting

**The “SP 700 cannot be used” message appears (Macintosh)**

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The printer software has been corrupted.</td>
<td>Remove and reinstall the printer software as described on page 6-5. Then, in the Extensions Manager, disable Quick Draw GX. Select <strong>SP 700</strong> in the Chooser, enable Monitor3, and restart your Macintosh.</td>
</tr>
</tbody>
</table>

**Your printer icon doesn’t appear in the Chooser (Macintosh)**

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Your system has extension conflicts.</td>
<td>In the Extensions Manager, disable Quick Draw GX. Choose <strong>SP 700</strong> in the Chooser, make sure EPSON Monitor3 is enabled, then restart your Macintosh.</td>
</tr>
</tbody>
</table>

**You sent several print jobs, but none are printing (Macintosh)**

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The print queue is on hold.</td>
<td>In the EPSON Monitor3 dialog box, select <strong>Start print queue</strong> from the Printer menu to release the queue and resume printing.</td>
</tr>
</tbody>
</table>

**You get a type 39 error on the Macintosh**

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The printer driver is corrupted.</td>
<td>Delete and reinstall the printer driver as described on page 6-6.</td>
</tr>
</tbody>
</table>

**You cannot print on a Windows NT 4.0 network**

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Your printer is not set up correctly as a remote printer.</td>
<td>You may need to use a different network path and printer port. Select a different port in the printer’s Properties windows and enter the new network path to your printer at the DOS prompt. Then restart your computer. See your Windows NT documentation for instructions on changing the printer port and network path.</td>
</tr>
</tbody>
</table>
Troubleshooting

Printing is too slow

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Your printer software options are set incorrectly.</td>
<td>For the fastest printing, try the following:</td>
</tr>
<tr>
<td></td>
<td>› Set Print Quality to Economy.</td>
</tr>
<tr>
<td></td>
<td>› Turn MicroWeave off.</td>
</tr>
<tr>
<td></td>
<td>› Turn High Speed on.</td>
</tr>
<tr>
<td></td>
<td>› Choose Black ink and No Halftoning.</td>
</tr>
<tr>
<td></td>
<td>See Chapters 1 and 3 for more information.</td>
</tr>
<tr>
<td>Your system doesn’t have enough resources.</td>
<td>› Clear space on your hard disk or run a defragmentation utility.</td>
</tr>
<tr>
<td></td>
<td>› Don’t run too many applications at the same time.</td>
</tr>
<tr>
<td></td>
<td>› Turn off virtual memory.</td>
</tr>
<tr>
<td></td>
<td>› Increase your system’s memory (RAM).</td>
</tr>
<tr>
<td>You’re using background printing on a Macintosh.</td>
<td>Select EPSON Monitor3 and choose Get Info from the File menu to increase the Memory Requirements for EPSON Monitor3. See page 4-14 for more information. If that doesn’t work, turn off background printing (you won’t be able to use EPSON Monitor3).</td>
</tr>
<tr>
<td>You’re not using ECP mode and/or DMA transfers.</td>
<td>If your computer supports ECP mode and/or DMA transfers, turn them on to speed up printing. See your computer documentation for details.</td>
</tr>
</tbody>
</table>

Fixing Paper Problems

You can avoid most paper handling problems by doing the following:

› Use smooth, high-quality media designed for ink jet printers that meets the media specifications on page B-2.

› Follow all loading and handling instructions included with the media.

› Load the media with the printable side face up, as described in the Getting Started guide or on page 3-3.

If you have problems with paper feeding, paper jams, or ejected paper, check here for solutions.
Troubleshooting

**Paper doesn’t eject fully or is wrinkled**

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>If the paper doesn’t eject fully, you may have set</td>
<td>Press the load/eject button to eject the paper. Then make sure you</td>
</tr>
<tr>
<td>the wrong paper size.</td>
<td>select the correct paper size in your application or printer software.</td>
</tr>
<tr>
<td></td>
<td>(See the paper specifications on page B-2 for the paper sizes you can</td>
</tr>
<tr>
<td></td>
<td>print with.)</td>
</tr>
<tr>
<td>If it’s wrinkled when it comes out, the paper may</td>
<td>See the paper specifications on page B-2 for paper thicknesses you can</td>
</tr>
<tr>
<td>be damp or too thin.</td>
<td>print with, as well as environmental requirements for storage.</td>
</tr>
</tbody>
</table>

**Paper doesn’t feed**

<table>
<thead>
<tr>
<th>Try this</th>
<th>Then do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remove</td>
<td>Check that the paper:</td>
</tr>
<tr>
<td>the stack</td>
<td>◗ Isn’t curled or creased.</td>
</tr>
<tr>
<td>of paper</td>
<td>◗ Isn’t too old (see page 3-3 or your paper packaging for more information).</td>
</tr>
<tr>
<td>from the</td>
<td>◗ Isn’t loaded above the arrow on the left edge guide.</td>
</tr>
<tr>
<td>sheet feeder.</td>
<td>◗ Isn’t jammed inside the printer. (If the paper out light is</td>
</tr>
<tr>
<td></td>
<td>flashing, paper is jammed.)</td>
</tr>
<tr>
<td></td>
<td>Then reload the paper as described on page 3-2, making sure the left edge</td>
</tr>
<tr>
<td></td>
<td>guide is adjusted to fit the paper’s width.</td>
</tr>
</tbody>
</table>

**Paper jams inside the printer**

<table>
<thead>
<tr>
<th>Try this</th>
<th>Then do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Turn off</td>
<td>Reload the paper as described in the <em>Getting Started</em> guide and</td>
</tr>
<tr>
<td>your</td>
<td>Chapter 3. If your paper jams frequently, make sure you:</td>
</tr>
<tr>
<td>printer,</td>
<td>◗ Use smooth, high-quality paper, loaded printable side up.</td>
</tr>
<tr>
<td>open the</td>
<td>◗ Fan the stack and then even the edges before loading it.</td>
</tr>
<tr>
<td>cover, and</td>
<td>◗ Don’t load paper above the arrow mark on the left edge guide.</td>
</tr>
<tr>
<td>remove all</td>
<td>◗ Adjust the left edge guide to fit the width of your paper.</td>
</tr>
<tr>
<td>the paper</td>
<td></td>
</tr>
<tr>
<td>that’s inside,</td>
<td></td>
</tr>
<tr>
<td>including any small pieces that may have torn off.</td>
<td></td>
</tr>
</tbody>
</table>
Multiple pages feed at the same time

<table>
<thead>
<tr>
<th>Try this</th>
<th>Then do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remove the stack of paper from the printer.</td>
<td>Make sure the paper isn’t too thin (see the paper specifications on page B-2).</td>
</tr>
<tr>
<td></td>
<td>Fan the edges of the stack of paper to separate the sheets.</td>
</tr>
<tr>
<td></td>
<td>Reload the paper as described in the <em>Getting Started</em> guide and in Chapter 3.</td>
</tr>
<tr>
<td></td>
<td>Make sure the paper edge guides are snug against the edge of the paper.</td>
</tr>
<tr>
<td></td>
<td>If too many copies of a page or document are printing, check the <em>Copies</em> settings in both the printer software and your application program. See page 2-12 (Windows) or page 2-17 (Macintosh) for more information.</td>
</tr>
</tbody>
</table>

Solving Miscellaneous Printout Problems

If your printout results are not what you expected, try these solutions.

Characters are incorrect or garbled

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Your printer is not the Windows default printer.</td>
<td>Select your printer as the default Windows printer. See your Windows documentation or Windows online help for instructions.</td>
</tr>
<tr>
<td>Your printer is not selected in the Macintosh Chooser.</td>
<td>Open the Chooser and select your printer. See the <em>Getting Started</em> guide for instructions.</td>
</tr>
<tr>
<td>If you’re using background printing on a Macintosh, spooled data may be corrupted.</td>
<td>Open the Extensions folder, EPSON folder, and Spool folder. Then delete any queued files. Increase the memory requirements for EPSON Monitor3, following the instructions on page 4-14.</td>
</tr>
<tr>
<td>AppleTalk is activated on a Macintosh.</td>
<td>If your printer is connected to the printer port, open the Chooser and make sure AppleTalk is inactive. Then turn your computer off and back on.</td>
</tr>
<tr>
<td>Printing is stalled.</td>
<td>In Windows, delete the stalled print jobs in Spool Manager (see page 4-4 for instructions). On a Macintosh, select the stalled print jobs in EPSON Monitor3 (see page 4-15) or open the Extensions folder, EPSON folder, and Spool folder, and then delete any queued files.</td>
</tr>
</tbody>
</table>
### Troubleshooting

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The interface cable is not securely connected.</td>
<td>Turn off your printer and computer. Then make sure the cable is connected securely and meets the printer’s specifications.</td>
</tr>
<tr>
<td>You’re using a switch box with your printer.</td>
<td>Connect the printer directly to your computer and try printing again.</td>
</tr>
<tr>
<td>Your video driver may be conflicting with the EPSON printer driver (Windows only).</td>
<td>Try using a standard VGA video driver (see your computer or video card documentation for instructions on changing video drivers). If your printout is correct, your video driver is interfering with the printer driver. Contact your computer or video card manufacturer to see if an updated driver is available.</td>
</tr>
</tbody>
</table>

### The margins are incorrect

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Margins are set incorrectly in your software application.</td>
<td>Check your software documentation for instructions on selecting the correct margins for your paper size. Make sure the margins are within the printable area of the page. See Appendix B for more information.</td>
</tr>
<tr>
<td>Paper settings in the printer software are incorrect for your paper size.</td>
<td>Select the correct paper settings for your paper size. Make sure the <strong>Printable Area</strong> setting is correct for your project. See Chapters 1 and 3 for more information.</td>
</tr>
</tbody>
</table>

### The image is inverted, as if viewed in a mirror

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>You used a Flip Horizontal option in your application software or the printer software.</td>
<td>Turn off the Flip Horizontal or mirror setting in your application software or the printer software. See page 2-4 for information.</td>
</tr>
</tbody>
</table>

### A portion of your image doesn’t print (Macintosh)

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Your system doesn’t have enough available memory.</td>
<td>Close any other applications you are running or turn off background printing.</td>
</tr>
<tr>
<td>You may need to increase the memory allocation for your application, EPSON Monitor3, or both.</td>
<td>Choose Get Info from the File menu and increase the memory requirements. See page 4-14 for more information. If this doesn’t work, turn off background printing (you won’t be able to use EPSON Monitor3).</td>
</tr>
</tbody>
</table>
## Troubleshooting

### The printer prints blank pages

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Your printer is not the Windows default printer.</td>
<td>Select your printer as the default Windows printer. See your Windows documentation or Windows online help for instructions.</td>
</tr>
<tr>
<td>Your printer is not selected in the Macintosh Chooser.</td>
<td>Open the Chooser and select your printer. See the <em>Getting Started</em> guide for instructions.</td>
</tr>
<tr>
<td>Paper settings in the printer software are incorrect for your paper size.</td>
<td>Select the correct paper settings for your paper size. See Chapter 1 for more information.</td>
</tr>
<tr>
<td>The print head nozzles are clogged.</td>
<td>Clean the print head following the instructions on page 5-1.</td>
</tr>
</tbody>
</table>

### Something on the page is wrong or missing

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>You have the wrong port selected on your Macintosh.</td>
<td>If your Macintosh has only one serial port, open the Chooser, click the SP 700 icon, and then select the modem port.</td>
</tr>
<tr>
<td>Your Macintosh has a built-in modem.</td>
<td>Connect the interface cable to the printer port. Then open the Chooser, click the SP 700 icon, and then select the printer port.</td>
</tr>
</tbody>
</table>
You can use your printer on a network under Windows 95, Windows 3.1, Windows NT 4.0, and other network operating systems. See the appropriate section below for your operating system.

**Network Printing in Windows 95**

If you want to print to a remote printer through a Windows 95 network, you must first set up your Windows 95 system as a client computer which can use the printer on a remote server. To set up the print server, see your Windows 95 documentation. To set up your system as a client, follow the instructions below:

1. Make sure your printer software is installed (see the *Getting Started* guide for installation instructions).
2. Double-click the **My Computer** icon.
3. Double-click the **Printers** folder.
4. Right-click the icon of your printer, and click **Properties**.
5. Click the Details tab. Then click the Add Port button.

![Image of Add Port dialog box]

Click this tab
Then click here

6. In the following dialog box, click Browse.

![Image of Browse button]

Click here to specify the network path
7. Double-click the icon of the computer that is directly connected to the printer. Then click the icon of the printer you plan to use on the network.

8. Click OK and follow the messages on the screen.

Now you can use the printer connected to the print server over the network from the client computer.

**Network Printing in Windows 3.1**

For printing on a Windows 3.1 network, you need to install the EPSON Stylus Photo 700 printer software on each computer that is going to print on the network. Then run Spool Manager and identify the shared directory to use for journal files. After you set this up on the print server (the system connected to the printer), you need to perform a similar procedure on each client system on the network.
Network Printing

Setting Up the Print Server in Windows 3.1

Follow these steps to set up the computer connected to the printer:

1. Create an icon for the EPSON Spool Manager (EPSPMGR4.EXE) in the \WINDOWS\SYSTEM folder.

2. Place this icon in the StartUp folder.

3. Open the Spool Manager window as described on page 4-11.

4. In the Spool Manager window, double-click the queue you want to use for network printing. The Queue Setup dialog box appears.

5. Click the Remote Despool tab and then click the Printing from remote queues option.

6. Click the Browse button and select the server directory that will receive journal files.

7. Click OK and minimize the Spool Manager.

Setting Up Client Systems in Windows 3.1

Follow these steps to set up computers on the network:

1. Create an icon for the EPSON Spool Manager (EPSPMGR4.EXE) in the \WINDOWS\SYSTEM folder.

2. Open the Spool Manager window as described on page 4-11.

3. In the Spool Manager window, double-click the queue you want to use for network printing. The Queue Setup dialog box appears.

4. Click the Spool to remote printer button.
5. Click the **Browse** button and select the directory you're using for journal files on the server.

6. Click **OK** and minimize the Spool Manager.

**Network Printing in Windows NT 4.0**

If you are connecting the printer directly to a print server and sharing access to it on the network, see your Windows NT 4.0 documentation for connection instructions for client workstations.
Printing

Printing method
EPSON’s exclusive drop-on-demand Micro Piezo ink jet technology

Nozzle configuration
- Black: 32 nozzles
- Color: 32 nozzles × 5 (cyan, magenta, yellow, light cyan, light magenta)

Printable columns and printing speeds

<table>
<thead>
<tr>
<th>Print quality</th>
<th>Printable width</th>
<th>Available dots</th>
<th>CR speed</th>
</tr>
</thead>
<tbody>
<tr>
<td>180 dpi</td>
<td>8.26 inches (209.8 mm)</td>
<td>1488</td>
<td>20 ips</td>
</tr>
<tr>
<td>360 dpi</td>
<td>8.26 inches (209.8 mm)</td>
<td>2976</td>
<td>20 ips</td>
</tr>
<tr>
<td>720 dpi</td>
<td>8.26 inches (209.8 mm)</td>
<td>5952</td>
<td>20 ips</td>
</tr>
<tr>
<td>1440 dpi</td>
<td>8.26 inches (209.8 mm)</td>
<td>11904</td>
<td>20 ips</td>
</tr>
</tbody>
</table>

dpi = dots per inch, ips = inches per second

Resolution
Maximum 1440 dpi × 720 dpi

Print direction
Bidirectional with logic seeking

Control code
ESC/P Raster™
### Technical Specifications

#### Paper

<table>
<thead>
<tr>
<th>Paper type</th>
<th>Size</th>
<th>Paper types</th>
<th>Thickness</th>
<th>Weight</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Single sheets</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Letter (8.5 x 11 inches)</td>
<td></td>
<td>Plain bond paper and special ink jet papers distributed by EPSON</td>
<td>0.003 to 0.004 inch (0.08 to 0.11 mm) for plain bond paper</td>
<td>17 to 24 lb (64 to 90 g/m²) for plain bond paper</td>
</tr>
<tr>
<td>Legal (8.5 x 14 inches)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Statement (5.5 x 8.5 inches)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Executive (7.5 x 10 inches)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A4 (210 x 297 mm)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A5 (148 x 210 mm)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B5 (182 x 257 mm)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Transparencies, Glossy film, Glossy paper</strong></td>
<td>Letter (8.5 x 11 inches)</td>
<td>Transparencies, glossy paper, and glossy film distributed by EPSON</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>A4 (210 x 297 mm)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A6 (105 x 148 mm, glossy film only)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Adhesive sheets</strong></td>
<td>A4 (210 x 297 mm)</td>
<td>Self adhesive sheets distributed by EPSON</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td><strong>Envelopes</strong></td>
<td>No. 10 9.5 x 4.1 inches</td>
<td>Plain bond paper or air mail paper</td>
<td>0.006 to 0.017 inch (0.16 to 0.43 mm)</td>
<td>12 to 20 lb (45 to 75 g/m²)</td>
</tr>
<tr>
<td>DL</td>
<td>(240 x 104 mm)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C6</td>
<td>4.4 x 6.4 inches</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(114 x 162 mm)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Index (ink jet) cards</strong></td>
<td>A6 (105 x 148 mm)</td>
<td>Ink jet cards distributed by EPSON</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>10 x 8 inches (254 x 203 mm)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Photo paper</strong></td>
<td>Letter (8.5 x 11 inches)</td>
<td>Photo paper distributed by EPSON</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>A4 (210 x 297 mm)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4 x 6 inches (102 x 152 mm)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Panoramic (210 x 594 mm)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Photo stickers</strong></td>
<td>A6 (105 x 148 mm), 16 frames per page</td>
<td>Photo stickers distributed by EPSON</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td><strong>Iron-on cool peel transfer paper</strong></td>
<td>Letter (8.5 x 11 inches)</td>
<td>Transfer paper distributed by EPSON</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>4 x 6 inches (102 x 152 mm)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Technical Specifications

Note:
Since the quality of any particular brand or type of paper may be changed by the manufacturer at any time, EPSON cannot attest to the quality of any non-EPSON brand or type of paper. Always test samples of paper stock before purchasing large quantities or printing large jobs.

Poor quality paper may reduce print quality and cause paper jams and other problems. If you encounter problems, switch to a higher grade of paper.

Do not load curled or folded paper.

Special papers distributed by EPSON are only usable under normal conditions:
Temperature: 59 to 77 °F (15 to 25 °C)
Humidity: 40 to 60% RH

Printouts on EPSON Photo Quality Glossy Film should be stored under the following conditions:
Temperature: 59 to 86 °F (15 to 30 °C)
Humidity: 20 to 60% RH

Printable area

A: The minimum top margin is 0.12 inch (3.0 mm).
When loading multiple sheets of EPSON Photo Quality Film, the minimum top margin is 1.2 inches (30 mm).

B: The minimum left and right margins are 0.12 inch (3.0 mm).

The minimum right margin for envelopes is as follows:
0.28 inch (7 mm) for DL envelopes.
1.10 inches (28 mm) for No. 10 envelopes.
0.12 inch (3 mm) for C6 envelopes.

C: The minimum bottom margin is 0.54 inch (14.0 mm).
Technical Specifications

EPSON 4 x 6-inch Photo Paper
(dotted lines indicate perforations)

A: The maximum top margin is 0.67 inch (17.0 mm).
B-L, B-R: The maximum left and right margin is 0.24 inch (6.1 mm).
C: The maximum bottom margin is 0.24 inch (6.1 mm).

EPSON Panoramic Photo Paper

A: The minimum top margin is 0.12 inch (3.0 mm).
B-L: The minimum left margin is 0.12 inch (3.0 mm).
B-R: The minimum right margin is 0.54 inch (14.0 mm).
C: The minimum bottom margin is 0.12 inch (3.0 mm).

Note:
Always load paper into the sheet feeder short edge first. However, envelopes should be loaded long edge first.
## Technical Specifications

### Ink Cartridge

<table>
<thead>
<tr>
<th>Specification</th>
<th>Black ink cartridge (S020093)</th>
<th>Color ink cartridge (S020110)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color(s)</td>
<td>Black</td>
<td>Cyan, Magenta, Yellow, Light Magenta, Light Cyan</td>
</tr>
<tr>
<td>Print capacity*</td>
<td>540 pages/A4 (ISO/IEC 10561 Letter Pattern at 360 dpi)</td>
<td>220 pages (A4, 360 dpi, 5% duty each color)</td>
</tr>
<tr>
<td>Cartridge life</td>
<td>2 years from production date (if unopened)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(within 6 months after opening package, at 77 °F (25 °C))</td>
<td></td>
</tr>
<tr>
<td>Storage temperature</td>
<td>Installed: –4 to 104 °F (–20 to 40 °C)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1 month at 104 °F (40 °C)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Uninstalled: –22 to 104 °F (–30 to 40 °C)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1 month at 104 °F (40 °C)</td>
<td></td>
</tr>
<tr>
<td>Transit temperature</td>
<td>–22 to 140 °F (–30 to 60 °C)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1 month at 104 °F (40 °C)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>120 hours at 140 °F (60 °C)</td>
<td></td>
</tr>
<tr>
<td>Freezing temperature**</td>
<td>5 °F (–15 °C)</td>
<td>1.4 °F (–17 °C)</td>
</tr>
<tr>
<td>Dimensions</td>
<td>0.7 (W) × 2.1 (D) × 1.5 (H) inches</td>
<td>2.0 (W) × 2.1 (D) × 1.5 (H) inches</td>
</tr>
<tr>
<td></td>
<td>19.8 (W) × 52.7 (D) × 38.5 (H) mm</td>
<td>51.4 (W) × 52.7 (D) × 38.5 (H) mm</td>
</tr>
</tbody>
</table>

* The print capacity may vary, depending on how often you clean the print head.

** Cartridges thaw and are usable after approximately 3 hours at 77 °F (25 °C).

** Caution:**
EPSON recommends the use of genuine EPSON ink cartridges. Other products not manufactured by EPSON may cause damage to your printer not covered by EPSON’s warranties.

Do not use an ink cartridge if the date on the package has expired.
Technical Specifications

Mechanical

- **Paper feed method**: Friction
- **Paper path**: Sheet feeder, rear entry
- **Sheet feeder capacity**: 100 sheets at 17 lb (64 g/m²) paper

Dimensions

- **Storage**: Width: 16.9 inches (429 mm)  
  Depth: 9.2 inches (234 mm)  
  Height: 6.4 inches (162 mm)
- **Printing (standard)**: Width: 16.9 inches (429 mm)  
  Depth: 22.9 inches (582 mm)  
  Height: 12.1 inches (307 mm)
- **Printing (on transparencies)**: Width: 16.9 inches (429 mm)  
  Depth: 26.1 inches (664 mm)  
  Height: 7.7 inches (196 mm)

- **Weight**: 11.5 lb (5.2 kg) without the ink cartridges

Electrical

<table>
<thead>
<tr>
<th>Specification</th>
<th>120 V Model</th>
<th>220–240 V Model</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input voltage range</td>
<td>99 to 132 V</td>
<td>198 to 264 V</td>
</tr>
<tr>
<td>Rated frequency range</td>
<td></td>
<td>50 to 60 Hz</td>
</tr>
<tr>
<td>Input frequency range</td>
<td></td>
<td>49.5 to 60.5 Hz</td>
</tr>
<tr>
<td>Rated current</td>
<td>0.4 A</td>
<td>0.2 A</td>
</tr>
</tbody>
</table>
| Power consumption                    | Approx. 15 W (ISO/IEC 10561 Letter Pattern)  
  Approx. 5 W in standby mode (120 V model)  
  Approx. 5.5 W in standby mode (220–240 V model) |

This product is also designed for IT power system phase-to-phase voltage 220–240 V.

**Note:**  
Check the label on the back of the printer for the voltage of your printer.
Environmental

Temperature

Operation  50 to 95 °F (10 to 35 °C)
Storage  –4 to 140 °F (–20 to 60 °C)
1 month at 104 °F (40 °C)
120 hours at 140 °F (60 °C)

Humidity (without condensation)

Operation  20 to 80% RH
Storage  5 to 85% RH

*Stored in shipping container

Safety Approvals

Safety standards  UL 1950 with D3, CSA C22.2 No. 950 with D3
EMC  FCC part 15 subpart B class B, CSA C108.8 class B

Initialization

The printer can be initialized (returned to a fixed set of conditions) in these ways:

| Hardware initialization | * The printer is turned on.  
|                         | * The printer receives an INIT signal from the parallel interface. |
| Software initialization | * Software sends an ESC @ (initialize the printer) command. |

Hardware initialization

When the printer is turned on, the printer mechanism is initialized and the input data buffer and print buffer are cleared. Printer settings are returned to their default values. However, the printer mechanism is not initialized if the printer is turned on within ten seconds after turning it off. In this case, the printer caps the print head, and ejects any paper in the paper path.

Software initialization

Software initialization clears the print buffer and returns printer settings to their default values. However, it does not initialize the printer mechanism or clear the data buffer.
Technical Specifications

Interface

Your printer is equipped with an 8-bit parallel interface and a serial interface.

Parallel interface

The built-in parallel interface has the following characteristics:

Forward channel

- Data format: 8-bit parallel, IEEE-1284 compatibility mode
- Synchronization: STROBE pulse
- Handshake timing: BUSY and ACKLT signals
- Signal level: TTL compatible
- Connector: 57-30360 Amphenol connector or equivalent

Reverse channel

- Transmission mode: IEEE-1284 Nibble mode
- Adaptable connector: 57-30360 Amphenol connector or equivalent
- Synchronization: Refer to the IEEE-1284 specification
- Handshaking: Refer to the IEEE-1284 specification
- Signal level: IEEE-1284 Level 1 device
- Data transmission timing: Refer to the IEEE-1284 specification

Serial interface

The printer’s built-in serial interface is based on the RS-423 standard. This interface has the following characteristics:

- Standard: Based on RS-423
- Synchronization: Synchronous
- Bit rate: Approx. 1.8 Mbps
- Handshaking: X-ON/X-OFF and DTR protocol
- Word format:
  - Data bit: 8 bits
  - Parity bit: None
  - Start bit: 1 bit
  - Stop bit: 1 bit

Connector

- 8-pin mini-DIN

Recommended cable

- Apple System Peripheral-8 cable (part number M0197)
### Glossary

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>banding</td>
<td>The horizontal lines that sometimes appear in a printed image. See also MicroWeave.</td>
</tr>
<tr>
<td>bidirectional</td>
<td>Moving the print head from left to right and right to left, for faster output.</td>
</tr>
<tr>
<td>buffer</td>
<td>The portion of the printer’s memory used to store data before printing it.</td>
</tr>
<tr>
<td>character table</td>
<td>A collection of letters, numbers, and symbols that provides you with the characters used in a particular language.</td>
</tr>
<tr>
<td>CMYK</td>
<td>Cyan (blue-green), magenta, yellow, and black. These colored inks are used to create printed colors. The addition of light magenta and light cyan increases the accuracy of photographic images for virtual continuous-tone printing.</td>
</tr>
<tr>
<td>ColorSync</td>
<td>Macintosh software that is designed to help you get WYSIWYG (what you see is what you get) output. This software prints colors as you see them on your screen.</td>
</tr>
<tr>
<td>default</td>
<td>A value or setting that takes effect when the equipment is turned on, reset, or initialized.</td>
</tr>
<tr>
<td>dithering</td>
<td>A halftoning method in which dots are arranged in an orderly pattern. Dithering works best for printing images with solid colors, such as charts and graphs. See also halftoning.</td>
</tr>
<tr>
<td>dpi</td>
<td>Dots per inch. The dpi measures the resolution. See also resolution.</td>
</tr>
<tr>
<td>driver</td>
<td>A software program that sends instructions to a computer device to tell it what to do. For example, your printer driver accepts print data from your image processing application and sends instructions to the printer on how to print this data.</td>
</tr>
</tbody>
</table>
Glossary

Error Diffusion  This halftoning setting smooths out edges by randomly placing dots of varying colors. This has the opposite effect of the Finest Detail setting.

ESC/P Raster  A version of the ESC/P (Epson Standard Code for Printers) command language, which gives you control of your printer from your computer. Commands in this language produce enhanced graphics printing.

Finest Detail  This setting automatically makes your printed images sharper and clearer. This has the opposite effect of the Error Diffusion setting. Be aware that this may increase the time required for printing.

font  A style of type designated by a name.

gamut  The range of colors that a device (such as a printer or monitor) can accurately reproduce.

grayscale  A scale of shades of gray from black to white. Grayscale is used to represent colors when printing with black ink only.

halftoning  A method of using dot patterns to represent an image. Halftoning makes it possible to produce varying shades of gray using only black dots, or a nearly infinite array of colors using only a few colors of dots.

host system  The computer connected directly to the printer in a network.

initialization  Process that returns the printer to its defaults (fixed set of conditions). This happens every time you turn on or reset the printer.

ink jet  A method of printing in which images, lines, letters, or symbols are formed by precisely spraying ink onto paper.

interface  The connection between the computer and a peripheral such as a printer. Some printers have two interfaces, parallel and serial. A parallel interface transmits data one byte, or eight bits, at a time. A serial interface transmits data one bit at a time.
Glossary

media  Materials upon which data is printed, such as envelopes, plain paper, special paper, and transparencies.

Micro Piezo  Ink jet technology that uses an electronic pulse to precisely force the ink through the print head. This results in smaller, cleaner dots, sharp lines, and crisp text.

MicroWeave  Printing technology that produces images in fine increments to reduce the possibility of banding. See also banding.

parallel interface  See interface.

print queue  Print jobs that are sent to the printer while it is busy are stored in a waiting line, or print queue, until they can be printed.

print server  The computer connected to the printer. It receives the jobs and then distributes them to the assigned printer. It also holds extra print jobs while the printer is busy. See also print queue.

printable area  The area of a page on which the printer can print. It is smaller than the physical size of the page due to margins.

printer driver  See driver.

RAM  Random Access Memory. The area of your computer’s memory that runs programs and stores data.

reset  To return a printer to its defaults either by sending a command or an INIT signal, or by turning the printer off and then back on.

resolution  The number of dots per inch used to represent an image.

ROM  Read Only Memory. Memory area in your printer or computer that cannot be modified. ROM retains its contents when you turn off the printer or computer.

saturation  The depth or vibrancy of a color; the amount of gray.

serial interface  See interface.
Glossary

**spool**  The process by which the printer driver converts the print data into codes that your printer understands. This data is then sent to the printer directly or to the print server.

**Spool Manager**  An EPSON software program that converts print data into codes that your printer understands. See also *spool*.

**Status Monitor**  An EPSON software program that displays the printer’s status, such as paper out or the amount of ink remaining before printing.
Index

A
Accessories, 6-1 to 6-10, 5-4
Advanced mode, selecting, 2-2
Advanced settings
  custom, 2-3 to 2-11, 2-34 to 2-35
  predefined, 2-2 to 2-4
Aligning print head, 2-3 to 2-4
Automatic mode, 1-3 to 1-8, 3-3

B
Background printing
  Macintosh, 4-14 to 4-15
  Windows 3.1, 4-11 to 4-13
  Windows 95, 4-5 to 4-10
Banding, 6-7
Banners, 3-8 to 3-12
Bitmap files, 2-25 to 2-26
Blank pages, 6-19
Blurry printouts, 6-8
Brightness setting, 2-9

C
Cards, see Photo Quality Ink Jet Cards
Characters, garbled, 6-17 to 6-18
Cleaning
  print head, 5-1 to 5-4
  printer, 5-9
  cleaning sheets, 3-3 to 3-5
  coated paper, 3-2
  Collate setting, 2-14 to 2-20
  Color
    customizing, 2-8 to 2-10
    problems, 6-8 to 6-9
  Color Adjustment modes, 2-8 to 2-10
  Colormetric setting, 2-11
  ColorSync, 2-3 to 2-11, 6-8
  CompuServe, 5

D
Default printer options, setting, 1-4 to 1-5
Deleting custom settings, 2-35
Deleting print jobs
  Macintosh, 4-15
  Windows 3.1, 4-12
  Windows 95, 4-4
Despooler, 1-7, 4-11
Diagnosing problems, 6-1 to 6-6
Digital camera images, 1, 2-3
Dithering, 2-6
DMA transfer, 4-3
Draft printing, 2-3

E
Economy setting, 2-3 to 2-6, 6-7
Electrical specifications, 6-7
ENERGY STAR, 6-7
Energy-saving tips, 7
Envelopes
  printing on, 3-2, 3-5
  specifications, B-2 to B-4
Environmental specifications, B-7
EPSON
  Accessories, 6, 1-10, 5-4
  Customer Care Centers, 5
  Electronic support services, 5 to 6
  help, 5 to 6
  media, 1-10, 3-2 to 3-3
  World Wide Web site, 5
Error Diffusion setting, 2-6
ESC/P Raster control code, B-1

F
  Film, see Photo Quality Glossy media
  Fine Dithering setting, 2-6
  Finest Detail setting, 2-7
  Fit to Page setting, 2-23, 2-28 to 2-29
  Flip Horizontal setting, 2-7, 3-3, 6-18
  FTP, 5

G
  Garbled characters, 6-17 to 6-18
  Glossy media, see Photo Quality Glossy media

H
  Halftoning setting, 2-6
  Head Cleaning utility, 5-2
  Help, EPSON, 5 to 6
  Help, online, 1-2, 6-2
  High Quality Ink Jet Paper
  choosing, 1-10
  printing on, 3-2
  High Speed setting, 2-7, 6-7
  Horizontal banding, 6-7
  ICM (Image Color Matching), 2-3, 2-8 to 2-10
  Index cards, see Photo Quality Ink Jet Cards
  Initialization, B-7
  Ink cartridge
    outdated, 5-7 to 5-8, 6-7
    replacing, 3-4 to 3-5, 6-7
    specifications, B-5
  Ink jet cards, see Photo Quality Ink Jet Cards
  Ink jet paper
    choosing, 1-10
    printing on, 3-2
    specifications, B-2 to B-3
  Ink jet Transparencies, see Transparencies
  Ink level, 4-9, 4-16
  Ink setting, 1-3, 1-9, 2-2, 2-6
  Interface specifications, B-8
  Internet, 5
  Iron-On Transfer papers
    choosing, 1-10
    printing on, 2-7, 3-2
    specifications, B-2 to B-3

J
  Jammed paper, 1-11, 6-2, 6-16
  Job Status window, 4-10
  Journal files, 4-11, A-4

L
  Labels, printing, 3-2
  Landscape orientation, 2-14, 2-18, 3-11
  Layout options
    Macintosh, 1-9, 2-27 to 2-33
    Windows, 1-3, 2-20 to 2-27
  Lever, thickness, 3-2, 3-5
  Lights, 1-11 to 1-12, 6-2 to 6-3
    6-9 to 6-11
M  
Macintosh  
managing print jobs,  
4-13 to 4-17  
Monitor3, 4-14 to 4-15  
6-13 to 6-15  
printing from, 1-7 to 1-9  
system requirements, 2 to 3  
uninstalling software, 6-6  
Magenta setting, 2-9  
Maintaining printer, 5-1 to 5-9  
Managing print jobs  
Macintosh, 4-13 to 4-17  
Windows 3.1, 4-11 to 4-13  
Windows 95, 4-1 to 4-10  
Windows NT, 4-13  
Manuals, how to use, 3 to 4  
Margins  
icorrect, 6-18  
with multiple sheets, 3-3 to 3-8  
Mechanical specifications, B-6  
Media Type setting, 1-3 to 1-9  
2-4  
2-6 to 3-2 to 3-3 to 3-6 to 3-7  
Memory error, 6-13 to 6-15  
MicroWeave setting, 2-7  
Mirror images, 2-7 to 3-3 to 6-18  
Missing image, 6-18 to 6-19  
Monitor3, 4-14 to 4-15  
6-13 to 6-15  
Monitoring preferences, 4-6 to 4-7  
Moving printer, 5-9  
Multiple print layouts  
Macintosh, 2-30  
Windows, 2-24  
N  
Network printing  
Windows 3.1, A-3 to A-5  
Windows 95, A-1 to A-3  
Windows NT, A-5  
No Halftoning setting, 2-6  
Nozzle Check  
pattern, 5-4 to 6-4  
utility, 5-2 to 5-4  
O  
Orientation setting, 2-14 to 2-18, 3-11  
P  
Page frames  
Macintosh, 2-30  
Windows, 2-24  
Page Order setting, 2-24 to 2-30  
Panoramic images  
choosing paper, 1-10 to 3-2  
loading paper, 3-8 to 3-9  
printing from Macintosh, 3-11 to 3-12  
printing from Windows, 3-10 to 3-11  
Paper  
banner, 3-8 to 3-9  
choosing, 1-10  
coated, 3-2  
glossy, see Photo Quality Glossy media  
handling problems, 6-15 to 6-17  
jams, 1-11, 6-2 to 6-16  
loading guidelines, 3-2 to 3-6  
menu, 1-3 to 1-8 to 3-10  
options, 2-12 to 2-20  
photo, see Photo paper plain, 3-2  
specifications, B-2 to B-4  
support, 3-8 to 3-9  
thickness lever, 3-2 to 3-5  
types, 1-3 to 1-9 to 1-10  
Paper sizes  
available in Windows, 2-13  
available on Macintosh, 2-17  
custom, 2-15 to 2-16 to 2-19  
3-8 to 3-12  
Perceptual setting, 2-11  
Photo paper  
choosing, 1-10  
printing on, 3-2 to 3-6 to 3-12  
specifications, B-2 to B-4
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page 1</th>
<th>Page 2</th>
<th>Page 3</th>
<th>Page 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Photo Quality Glossy media</td>
<td>1-10</td>
<td>3-2</td>
<td>B-2</td>
<td>B-3</td>
</tr>
<tr>
<td>Photo Quality Ink Jet Cards</td>
<td>1-10</td>
<td>3-2</td>
<td>3-6</td>
<td>B-2</td>
</tr>
<tr>
<td>Photo Quality Ink Jet Cards</td>
<td>1-10</td>
<td>3-2</td>
<td>3-6</td>
<td>B-2</td>
</tr>
<tr>
<td>Photo Quality Self Adhesive Sheets</td>
<td>1-10</td>
<td>3-2</td>
<td>B-2</td>
<td>B-3</td>
</tr>
<tr>
<td>Photo setting</td>
<td>2-3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Photo stickers</td>
<td>1-10</td>
<td>3-3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Portrait orientation</td>
<td>2-14</td>
<td>2-18</td>
<td>3-7</td>
<td>B-1</td>
</tr>
<tr>
<td>Predefined advanced settings</td>
<td>2-2</td>
<td>2-4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Print head</td>
<td>5-8</td>
<td>6-7</td>
<td>5-1</td>
<td>5-4</td>
</tr>
<tr>
<td>Print jobs, managing</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Macintosh</td>
<td>4-13</td>
<td>4-17</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows 3.1</td>
<td>4-11</td>
<td>4-13</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows 95</td>
<td>4-1</td>
<td>4-10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Window NT</td>
<td>4-13</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Progress Meter</td>
<td>1-6</td>
<td>2-21</td>
<td>2-23</td>
<td>2-28</td>
</tr>
<tr>
<td>Quality/Speed setting</td>
<td>1-3</td>
<td>1-9</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
ReadMe files, 6-2
Rendering Intent setting, 2-11
Replacing ink cartridges, 5-4 to 5-8
Resolution, see Print quality
Reverse Order setting, 2-14 to 2-20
Rotate by 180° setting, 2-12 to 2-14

Safety approvals, B-7
instructions, 7 to 9
Saturation setting, 2-9 to 2-11
Saving custom settings, 2-33
ScanDisk, 6-12
Scanned images, 2-3
Self adhesive sheets, see Photo Quality Self Adhesive Sheets
Self test, 6-3 to 6-4
Service, 8 to 9
Slow printing, 6-15
Smears, 3-5 to 3-7
Special effects, 2-4 to 2-7
Special media, 3-1 to 3-8
Specifications
electrical, B-6
environmental, B-7
initialization, B-7
ink cartridge, B-5
interface, B-8
mechanical, B-6
paper, B-2 to B-5
printing, B-1
safety approvals, B-7
Speed & Progress options, 4-1 to 4-3
Spool directory, 4-12
Spool Manager
problems, 6-10 to 6-13
Windows 3.1, 4-11 to 4-13
Windows 95, 4-4
Status Alert dialog box, 4-6 to 4-7

Status Monitor
Macintosh, 4-16
problems, 6-12
Windows, 1-6 to 4-5 to 4-10
Stickers, see Photo stickers
Super MicroWeave setting, 2-7
Support, 5 to 6
System requirements
Macintosh, 2 to 3
Windows, 2

Testing printer, 6-3 to 6-4
Text setting, 2-3
Text/Graph setting, 2-3
Thickness lever, 3-2 to 3-5
Transparencies
choosing, 1-10
print quality, 3-3 to 3-8
specifications, B-2 to B-3
Transporting printer, 5-9
Troubleshooting, 6-1 to 6-19

Uninstalling printer software
Macintosh, 6-6
Windows 3.1, 6-6
Windows 95, 6-5
User Defined paper sizes, 2-15 to 2-16, 2-19, 3-10 to 3-12
Utilities
Configuration, 4-17
Head Cleaning, 5-2
Nozzle Check, 5-2 to 5-4
Print Head Alignment, 5-8
Printer and Option Information, 6-4 to 6-5
Status Monitor, 1-6
4-5 to 4-10, 4-16 to 6-12

Video camera images, 2-3
Watermark
  Macintosh 2-31 to 2-33
  Windows 2-25 to 2-27
Windows
  managing print jobs, 4-1 to 4-13
  printer status, checking, 1-6 to 1-7
  printing from, 1-1 to 1-4
  Spool Manager, 4-4
  4-11 to 4-13
  system requirements, 2
  uninstalling printer software, 6-5 to 6-6
World Wide Web, 3

Yellow setting 2-9